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Before you begin

1is learner guide is based on the unit of competency BSBITU314 Design and produce 
spreadsheets, Release 1. Your trainer or training organisation must give you information 
about this unit of competency as part of your training program. You can access the unit of 
competency and assessment requirements at: www.training.gov.au.

How to work through this learner guide
1is learner guide contains a number of features that will assist you in your learning. Your 
trainer will advise which parts of the learner guide you need to read, and which practice 
tasks and learning checkpoints you need to complete. 1e features of this learner guide are 
detailed in the following table.

Icon Feature of the 

learner guide

How you can use each feature 

Learning content Read each topic in this learner guide. If you come across 

content that is confusing, make a note and discuss it with 

your trainer. Your trainer is in the best position to offer 

assistance. It is very important that you take on some of 

the responsibility for the learning you will undertake.

Examples These highlight learning points and provide realistic 

examples of workplace situations.

Practice tasks Practice tasks give you the opportunity to put your skills 

and knowledge into action. Your trainer will tell you which 

practice tasks to complete.

Video clips Where QR codes appear, you can use a smartphone or 

other device to access video clips relating to the content. 

For information about how to download a QR reader app or 

accessing video on your device, please visit our website: 

www.aspirelr.com.au/help

Summaries Key learning points are provided at the end of each topic.

Learning 

checkpoints

There is a learning checkpoint at the end of each topic. Your 

trainer will tell you which learning checkpoints to complete. 

These checkpoints give you an opportunity to check your 

progress and apply the skills and knowledge you have 

learnt.



viii
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU314
Design and produce spreadsheets

Foundation skills
As you complete learning using this guide, you will be developing the foundation skills 
relevant for this unit. Foundation skills are the language, literacy and numeracy (LLN) 
skills and the employability skills required for participation in modern workplaces and 
contemporary life.

1e following table outlines speci9c foundation skills noted for your learning in this 
learner guide. 

Foundation skill area Foundation skill description

Reading  • Recognises and interprets numerical and textual information to 

determine organisational and task requirements

Writing  • Inputs numerical and key reporting information when creating 

and �nalising spreadsheets and uses format, layout, style guides 

and standard naming conventions to organise data according to 

purpose and audience

Oral communication  • Participates in exchange of information to determine whether 

formulae utilised produce result required

Numeracy  • Uses mathematical equations to create simple formulae and 

validate numerical data

Navigate the world of work  • Recognises and follows explicit and implicit protocols and meets 

expectations associated with own role

Interact with others  • Collaborates with others to achieve joint outcomes

Get the work done  • Uses advanced features within relevant digital applications to 

address routine and complex work tasks
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Topic 1 
Prepare to use spreadsheets

A spreadsheet is a very useful computer application that makes it easy to carry 

out repetitive tasks involving numbers. 

Organisations use spreadsheets to store and calculate numerical data such as 9nancial 
statements or product pricing information. Setting up a spreadsheet is a simple form of 
computer programming. Most people in business or working in an o
ce will be expected to 
use and produce spreadsheets.

Once you have created a spreadsheet, you need to format it to make the information it 
contains easy to understand. When formatting a spreadsheet you may need to ensure it 
complies with the organisation’s style guidelines.

In this topic you will learn about:

1A Using safe and e
cient work practices

1B Identifying task requirements and selecting the best application 
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Workplace safety is everyone’s responsibility. 

Both employers and employees must make an active 
contribution to ensuring their workplace is safe. 
Hazards need to be identi9ed and risks assessed to 
reduce the risk of injury in the workplace. If you are 
working at a computer for an extended period of time 
each day, your workstation must be comfortable and 
designed to help you carry out your tasks e
ciently. 
You will need to organise your work so that you are 
not doing a repetitive task for a long time. You should 
also take regular breaks to stand up and stretch. 

Another consideration is to use resource 
conservation techniques to prevent wastage. Most 
organisations require staB to follow resource-saving 
procedures such as turning oB lights in unused rooms and recycling paper. You need to be 
aware of any conservation eBorts made by your organisation.

Health and safety legislative requirements

You must work in line with legislative requirements, regulations, Australian and 

industry standards, and the relevant codes of practice.

All health and safety legislation requires employers to provide a safe workplace and 
adequate training and supervision, while controlling workplace hazards and risks. 

Health and safety regulations support the legislation by outlining speci9c health and safety 
requirements that must be addressed.

1e Model Work Health and Safety (WHS) Regulations provide a framework that has been 
adopted by all Australian states and territories except for Victoria and Western Australia, 
which have their own legislation and regulations. 

Health and safety legislation outlines legal requirements such as:

 • managing risks to health and safety

 • promoting and maintaining the health, safety and welfare of people at work

 • protecting people at work from injury and illness, including psychological injury

 • protecting the health and safety of the public in workplaces

 • consulting workers and encouraging them to maintain health and safety

 • providing rehabilitation and maximum recovery for injured workers.

1A Using safe and e-cient work practices
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Health and safety policies and procedures

Health and safety policies and procedures are documents that ensure all 

employees work safely and e ectively. 

All workplaces in Australia are required to have a health and safety policy in place that 
describes the organisation’s and employees’ responsibility for maintaining health and safety. 
1e policy should include the organisation’s goals and objectives regarding health and 
safety, and can help you ful9l your duty of care as an employee.

1e following information relates to working in an o
ce and using a computer workstation, 
and should be contained in an organisation’s health and safety procedures.

Health and safety procedures outline:

 • workstation ergonomics

 • standard safety precautions and housekeeping

 • safe handling of hazardous substances, e.g. cleaning products

 • emergency and �re drills

 • hazard identi�cation and risk control

 • manual handling

 • emergency contact numbers, including local doctors and hospitals

 • location of �rst-aid equipment 

 • details of �rst-aid of�cers.

Control risks associated with hazardous manual tasks

It is a legal requirement for the PCBU and workers to address the risks 

associated with hazardous manual tasks in the workplace. 

1e WHS Regulations and the Code of Practice for Hazardous Manual Tasks outline 
speci9c requirements for hazardous manual tasks that must be addressed. 

A person conducting a business or undertaking (PCBU) must manage risks to health and 
safety associated with undertaking a hazardous manual task, including risks of developing a 
musculoskeletal disorder (MSD).

1e Hazardous Manual Tasks Code of Practice helps PCBUs and workers to:

• identify hazardous manual tasks

• assess the risks

• control the risks

• review the control measures.

A PCBU must consult with workers, so far as it is reasonably practical, to develop their own 
set of procedures to manage the risk of MSDs.



4
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU314
Design and produce spreadsheets

To determine which control measures to implement, the PCBU must consider the 

following:

 • postures, movements, forces and vibration relating to the hazardous manual task

 • the duration and frequency of the hazardous manual task

 • work conditions that may affect the hazardous manual task or the worker 

 • the design of the work area and layout of the workplace

 • the systems of work used

 • the nature, size, weight or number of people, animals or things involved in carrying 

out the hazardous manual task.

Musculoskeletal disorders 

The repetitive movements and sustained body position associated with 

entering data into a computer is regarded as a hazardous manual task and puts 

the operator at risk of developing an MSD. 

MSDs come about in two main ways:

• gradual wear and tear to joints, ligaments, muscles and inter-vertebral discs through 
repeated or continuous use of the same body parts, including static body positions

• sudden damage caused by strenuous activity or unexpected movements, such as when 
loads being handled move or change position suddenly.

MSDs may include conditions such as: 

 • sprains and strains of muscles, ligaments and tendons

 • back injuries, including damage to the muscles, tendons, ligaments, spinal discs, 

nerves, joints and bones

 • joint and bone injuries or degeneration, including injuries to the shoulder, elbow, 

wrist, hip, knee, ankle, hands and feet

 • nerve injuries or compression, e.g. carpal tunnel syndrome

 • muscular and vascular disorders as a result of hand–arm vibration

 • soft tissue hernias

 • chronic pain.

Standard precautions

Your organisation may require you to use standard precautions, particularly 

work practices related to the prevention of repetitive strain injuries (RSIs). 

1ese include ergonomic practices, workstation design, enforced breaks and regular exercise 
routines. A workstation includes a computer, monitor, keyboard, mouse, desk and chair.

Workers in an o
ce are expected to follow standard precautions when using a workstation, 
particularly at a sit-down desk. Research on sitting has demonstrated that other precautions 
also need to be considered, such as the use of standing workstations, to ensure that injuries 
are prevented. It is important that you carefully follow any standard precautions that are 
prescribed for your workplace.
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Equipment and systems safety checks

An important part of your daily work routine is to check the various systems 

and equipment you use during the day to make sure they are in good working 

order. 

Your organisational policies and procedures should include steps to follow. You may need 
to perform this procedure at the start of your work day or at speci9ed intervals throughout 
the day.

Workstation safety procedure/checklist:

 • Ensure your seat is positioned in front of your computer and that you can reach your 

keyboard comfortably.

 • Position the monitor out of direct sunlight and at the correct height. 

 • Ensure the environment is dust-free as dust can affect the monitor or the computer’s 

central processing unit (CPU).

 • Ensure cables are secured so no one trips over them.

 • Use blinds and window coverings to reduce glare and heat at your workstation.

 • Ensure temperatures do not exceed 26°C and that humidity is between 40 and 60 

per cent.

Ergonomics

The aim of ergonomics is to reduce the risk of accidents, injury and illness by 

applying safe work practices. 

Ergonomics is about creating comfortable working 
conditions by adapting workstations, tools and 
equipment to an individual worker’s needs. It 
also improves performance and productivity in 
the workplace. Ergonomics covers all aspects of 
working, from physical stresses such as sitting at a 
workstation all day to environmental factors such 
as noise, air conditioning and lighting.

When your posture is poor, you may suBer from 
aches and pains. Spending a long time in the same 
position can put stress on your body and this can 
be made worse if you are in an uncomfortable or 
poorly supported position. 1ese symptoms may be very slight at 9rst, but if you continue to 
have poor posture your symptoms may get worse and become intolerable. 1ey may result 
in cumulative stress given the constant strain on your muscles, nerves or tendons. 

When setting up your workstation, make sure your posture will not cause you pain or 
discomfort. 1e equipment you use needs to be adjusted to suit your body shape and size, 
and the tasks you are doing.
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Ergonomic workstation design

How your workstation is designed can a ect your health and wellbeing. 

Several physical problems can result from poor workstation design; for example, lower back 
strain may result from sitting in a chair that does not support your back. Some features of 
the workstation may vary depending on the type of computer work being performed. 

Below are some guidelines for setting up an ergonomic workstation. 

Chair

Adjust the seat height to suit your furniture and equipment. Ensure 

that your feet are �at on the �oor, your thighs are horizontal and 

your lower legs are vertical. If possible, use a chair with a �ve-

castor base.

Adjust the backrest by raising it to the maximum height and then 

lowering it until it �ts the curve of your lower back. If this is not 

comfortable, lower it another couple of centimetres. Continue this 

until it reaches a comfortable position. 

The backrest should support your lower back, and may also be 

adjusted backwards and forwards. When seated in your usual 

working position, move the backrest until it has a gentle pressure 

on your lower back. Make sure there is at least 2cm of space 

between the front of the seat and the back of your knees. Armrests 

should be positioned so that they do not interfere with carrying out 

your work tasks.

Desk

Keep your head erect when seated at your desk, and ensure that 

the surface of the desk is just below elbow height. 

If your desk is not height-adjustable, try to raise your chair so you 

are sitting at the correct height, and use a footrest, if necessary, 

to make up the difference. Ensure there is clearance between the 

lower edge of the desk and your legs, and between the front edge 

of your seat and your desk.

If your desk is too low, you may be able to extend the legs. You 

should have plenty of leg space underneath your desk. Don’t 

clutter the space with bags and bins, as your legs may become 

cramped and your posture may become twisted. 

Position any equipment or materials you use so that you can reach 

them easily without twisting. For example, place frequently used 

stationery in the top desk drawer, and ensure your keyboard and 

monitor sit directly in front of you to avoid having to twist your body.
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Keyboard

The angle of your keyboard can be adjusted to suit you by moving 

the supports underneath it. Place the keyboard as close as 

possible to the front of your desk. Have your upper arms hanging 

freely. Your forearms should be approximately horizontal.

While typing it is best not to rest your wrists, as they should not 

be bent up, down or to the side. The knuckle, wrist and top of the 

forearm should form a straight line. Wrist supports give you a place 

to rest your hands only when pausing from typing, not while you 

are typing. Do not pound the keys; instead, use a light touch. Leave 

enough room on your desk to put the keyboard out of the way when 

you are not using it.

Don’t place documents between yourself and the keyboard, 

as stretching will eventually cause muscle strain in your arms, 

shoulders and neck. 

Mouse

Place the mouse and mouse pad directly beside your keyboard on 

the side you prefer. If you use the mouse frequently, you could try 

to alternate sides. You will be surprised at how easy this becomes 

with practice. Your wrist should be straight and the desk should 

support the weight of your wrist, not your arm. Try to keep your 

wrist �at and rest your �ngers on the mouse between clicks. Hold 

the mouse lightly. Don’t hold onto the mouse when you are not 

using it.

Monitor

Once you have adjusted your chair and desk, you can position 

your monitor. Adjust it so that the top of the monitor is level with or 

slightly lower than your eyes. If you can’t adjust the monitor to the 

correct height, place it on a platform.

The viewing distance should be between 40 cm and 70 cm. The 

screen angle should be adjustable between 85 and 125 degrees. 

It is best to position the screen so that you can clearly read the text 

without having to lean forward, twist your neck or look upwards. 

A relaxed viewing angle is approximately 35 degrees. Place a 

document holder beneath or beside the monitor at the same 

viewing distance as the screen.

Also take surrounding factors into consideration, such as re�ection, 

glare and shadow, when positioning your screen. You may need to 

use an anti-glare �lter.
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Desktop layout

Items on your desk, including equipment and resources, should be arranged so 

they are within easy reach.

Your desk area can be divided into three zones:

• the optimum reach zone – the area closest to you, where your hands operate most of 
the time

• the maximum reach zone – items are further away, but still close enough to reach 
comfortably

• the outer reach zone – where you may have to bend forward or stand to reach items.

Make sure your desk is organised so that frequently used objects, such as your keyboard, are 
close to you. Objects that are used less frequently, such as your phone, should be out of the 
way but still within easy reach. Other resources that are rarely used, such as in- and out-
trays, should be in the outer reach zone.

1e following outlines some devices that can help you maintain a good posture at your 
workstation.

A footrest 

may be 

necessary 

if you 

can’t place 

your feet 

comfortably on 

the �oor. Footrests 

allow your feet to rest 

at the correct height and 

on a tilting angle, which prevents 

strain on the lower back. 

If you 

use a 

telephone 

for long 

periods of 

time, it is a 

good idea to 

use a headset. A 

headset will keep your 

neck straight and your 

arms free. Headsets prevent you 

from bending your neck to support the 

telephone handpiece.

Angle boards allow the user to maintain 

the correct posture when reading by 

reducing the angle between the work 

surface and the user. These supports 

can be adjusted to a suitable height and 

angle, and enable comfortable reading 

with the neck correctly positioned. Try to 

keep your neck as straight as possible 

when you are reading.

Document holders are designed to 

hold papers and reference material in 

a convenient position for viewing. Place 

your document holder in the correct 

position. If it is below the screen or too 

far off to the side, each time your eyes 

look from one source to the other, your 

pupils have to adjust. Doing this for 

long periods of time can cause 

headaches and eyestrain. 

Place the document 

holder at a similar 

level, angle and 

distance as 

the screen to 

avoid having 

to shift your 

eye focus.
D
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Setting up a home o-ce

Communication technology and organisational policies to maintain a 

sustainable work–life balance have created opportunities for more 0exible 

working arrangements. 

1is means that more employees are working from home o
ces or in other remote o
ce 
locations. Many bene9ts can be derived from Iexible working arrangements for employers 
and employees, but there is still a responsibility for all parties to make sure that home and 
remote o
ces use ergonomic practices and follow health and safety requirements.

Hot desking

Hot desking refers to a system where workstations are not assigned to an 

individual worker, but may be used by multiple workers during di erent periods 

of time. 

1e motivation behind hot desking is primarily the cost savings achieved by setting up 
fewer workstations when not all the workers are in the o
ce at the same time. 

Another common adaptation of hot desking is where workstations are assigned to 
individual workers, but need to be readily available for other workers to access based on 
daily work requirements, such as a group of people coming together to work on a speci9c 
project.

Considerations with hot desking:

 • It is common for workers to want their own space. Consequently, they may choose 

one location and stick to it.

 • It can take extra time each day to set up a workstation for each individual to 

maintain good ergonomics and work ef�ciency. 

 • Personal hygiene needs to be maintained to prevent the spread of germs on items 

such as keyboards and mouses.

 • Workstations need to be tidied appropriately in readiness for the next user. 

Bene1ts of using standing desks

Sitting at a desk for long periods of time has 

many negative health e ects. 

1ese can be overcome by using standing desks. 
Standing provides a greater opportunity for your 
body to move and adjust, and involves more 
muscular activity than sitting. 

Some studies have shown that the negative eBects of 
prolonged sitting cannot be counteracted by regular 
exercise. 1e only way to eliminate the problem is to 
avoid sitting as much as possible. 
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Some of the health bene9ts of standing include:

• alleviating back pain and other repetitive strain injuries by greater use of core back 
muscles to support the upper body

• increasing focus, alertness and activity level by releasing restless energy

• reducing the risk of developing cardiovascular disease, diabetes and blood clots, which 
can be caused by prolonged sitting.

It is recommended that you start using a standing desk gradually by alternating between 
sitting and standing. Using a standing desk for hours on end requires your body to adapt. 
You may experience sore feet, tired legs and fatigue at 9rst. Wear comfortable shoes and use 
an anti-fatigue Ioor mat to help counteract this.

Ensure you have an ergonomically designed standing desk so that you maintain correct 
posture while working. 

Standing desk recommendations:

 • Position arms at 90 degrees when standing.

 • Place the computer screen at eye level and tilt it slightly upwards.

 • Place the computer monitor at least arm’s length away.

 • Keep your back straight and avoid leaning on the desk.

Monitor and adjust lighting

Good lighting is essential for a safe and hazard-free workplace. 

You need to see things clearly in order to work eBectively. Simply shiJing the screen angle, 
adjusting blinds, altering the brightness settings on the screen and using desk lamps can 
reduce risks associated with poor lighting. Try to use natural sunlight rather than arti9cial 
lights if possible. If not, keep bulbs and 9xtures clean, focus light on your task and use 
Iuorescent lights to minimise eye strain and headaches.

The following are hazards associated with poor lighting:

 • Glare – A computer screen positioned in front of a bright window can be dif�cult to 

see.

 • Flickering lights – A �uorescent light may malfunction, causing annoyance, irritation 

and even nausea.

 • Inadequate lighting – Reading in dim light can cause eyestrain.

 • Shadows – Shadows shifting across your work area can cause you to sit with bad 

posture in order to view your work.
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Manage noise in the workplace

Noise can include any ongoing, loud or disturbing sound. 

Excessive noise around machinery or equipment can cause permanent hearing loss. 
Noise is a problem if it disturbs or distracts employees, causes stress or interferes with 
communication or work.

Many o
ces are open-plan, oJen with employees seated close to each other and divided 
by partitions at chest or head height. 1ink about noise levels when you set up your 
workstation. It should be possible for people in open-plan o
ces to have some privacy when 
they are on the phone and carrying out their day-to-day tasks.

Noise in the o
ce can come from:

• machines and equipment, such as photocopiers, fax machines, phones and printers

• outside tra
c and road works

• people talking to each other or on the phone.

Noise can also be a problem in other workplaces, such as on factory Ioors and at 
construction sites. You may have to wear ear protection if you are required to work in an 
excessively noisy environment.

1ere are many ways that noise can be controlled in the workplace. Examples include: 

• Noisy machines can be put in a separate room or area. 

• Sound-absorbent materials such as carpet and partitions can be installed or arranged to 
deIect and absorb noise. 

• 1e volume level on your speakers can be adjusted.

Remember that noise is only a hazard when it is stopping you from working productively, 
comfortably or safely. Many people prefer to work with low levels of noise rather than 
complete silence.

Monitor and adjust air conditioners

Air-conditioning systems may cause hazards due to poor-quality air or 

inadequate temperatures.

Air-conditioned o
ces oJen do not have enough 
fresh air from open windows. 1is can cause 
problems for some people. 1e air quality may need 
to be adjusted by allowing more fresh air inside or by 
improving the ventilation system.

Additionally, o
ce workers frequently complain of 
being too hot or too cold. If a person’s desk is near 
an air-conditioning outlet, the area around their 
desk can be much colder than elsewhere in the o
ce. 
1ey can also suBer from dry and itchy eyes. Report 
such hazards to the relevant person. 1is situation 
can usually be corrected by adjusting air-conditioner 
settings.
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Vary your activities

Make sure you plan your daily tasks so that you aren’t doing repetitive work for 

long periods of time.

Having a well-planned workstation and comfortable surroundings is pointless if you don’t 
organise your work in a way that prevents discomfort or pain. 

Your work role may involve several diBerent tasks. Some tasks may be repetitive, such as 
typing up reports or entering data. If you are able to vary the tasks you carry out each day, 
this will help to prevent repetitive actions that cause stress to your body. For example, if you 
have to enter a lot of data, break up the repetitive nature of the task by discussing a project 
with a colleague, doing some research online or doing another work task. 

You should also take regular breaks. Employers are required to allow employees to take rest 
periods throughout the day, including tea and lunch breaks, to reduce stress and fatigue.

Take exercise breaks

Using computers for too long without breaks has been associated with back 

and neck pain, headaches, migraines and eyestrain.

Try the following exercises several times a day, and encourage your colleagues to try 
them too. Make sure you are relaxed and stretch gently, without overstretching. Stop if 
you feel any pain or discomfort, and remember to exercise both sides of your body. Most 
importantly, breathe deeply and evenly throughout the stretch.

 • Neck: Turn your head gently to look over your right shoulder. Hold for 10 seconds. 

Now roll your head forward to look over your left shoulder and hold for 10 seconds. 

Repeat several times.

 • Shoulders: Sitting with a straight back and neck, roll your shoulders forward, then 

back. Repeat several times.

 • Wrists, hands and arms: Interlacing �ngers, turn your palms upwards. Now lift your 

arms over your head and stretch, leaning gently to the left and then to the right. 

Repeat movement several times.

 • Upper and lower back: In a standing position, place your hands in the small of your 

back. Gently arch your back and hold for 10 seconds. Repeat when needed.

 • Shoulders and arms: Stretch your arms above your head, cradle your elbow with 

your hand and gently pull your elbow behind your head. Repeat on the other side, 

holding the stretch for 10 seconds.

 • Eyes: Every 20 minutes, look away from the screen. Focus on a distant object (more 

than three metres away).

Watch a video demonstration of the above 

exercises here.

v1323
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Practise conservation techniques

Conserving resources at work not only bene5ts the organisation by reducing 

costs, but also the planet by reducing greenhouse gases and the amount of 

waste sent to land5ll. 

Most organisations have policies and procedures for conserving resources. You can 9nd out 
what these are by reading your workplace manual, or by asking your manager or colleagues.

1e following outlines ways to conserve resources at work.

Minimise paper wastage

Policies for reducing paper wastage include:

 • using both sides of the paper when printing and photocopying

 • recycling non-con�dential waste paper 

 • reducing the volume of printing where possible

 • reusing paper by using blank sides for rough drafts 

 • using recycled paper or paper from plantation timber for printed documents.

Reduce energy use

Policies and procedures for saving energy include:

 • providing training programs on smart energy practices so that employees can 

practise energy ef�ciency

 • turning off lights and equipment when not in use

 • keeping air conditioners at 18–20°C in winter and 24–27°C in summer

 • using power-saving functions on devices such as computers and tablets.
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Practice task 1

Question 1 

Here is a checklist to follow when setting up your workstation. Go through the points that are 

relevant to you and make any necessary adjustments to your work area. You may need another 

person to help you and check your posture. If you are not able to tick some of the checkpoints, 

discuss making alterations to your workstation with your manager.

Chair

Is the seat height-adjustable?

Is it high enough to allow you to sit comfortably at the keyboard?

Is it stable?

Does it swivel?

Is the height of the backrest adjustable and does it tilt backwards and forwards?

If it has arms, can you still get close enough to the desk and swivel the chair?

Are your feet �at on the �oor or are you using a footrest?

Are you sitting up straight with the backrest �rm against your back?

Desk

Is it large enough to allow the screen and keyboard to be correctly positioned?

Is it low enough to allow you to keep your forearms horizontal or sloping downwards?

Is it high enough to allow your thighs to �t comfortably underneath?

Keyboard

Can it be tilted to allow you to adjust it?

Are the symbols on the keys clear and easy to see?

Is there suf�cient space in front of it to allow you to correctly position your arms?

Monitor

Does the monitor have easily adjustable brightness and contrast controls?

Is the image on the monitor stable and �icker-free?

Are there adjustment mechanisms to allow the monitor to be tilted, swivelled or raised to 

avoid glare and re�ections, and help you keep a natural and relaxed posture?

Are you sitting far away enough from it for comfort?
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Question 2 

Describe the possible consequences for an organisation in which employees do not consider 

their physical health.

Question 3 

What should a WHS policy include?

Question 4 

What should WHS procedures include?

Question 5 

Why should you vary the tasks you carry out each day?
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Question 6 

Look at the following statements about conserving resources and decide whether they are true 

or false.

a. Screen savers help to save energy.

 � True  � False

b. Turning off computers crashes the hard drive.

 � True  � False

c. Re�lled toner or ink cartridges leak everywhere and make an incredible mess.

 � True  � False

d. Putting computers into sleep mode when they are inactive helps to save energy.

 � True  � False

e. Printing and �ling all documents in hard copy does puts a high demand on resource 

consumption.

 � True  � False
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All organisations need to manage and store numerical data, and a spreadsheet 

is the most appropriate tool for doing this.

Organisations use spreadsheets to store and calculate 
numerical data, which can then be used to produce 
such things as charts, graphs, statements and reports. 
In accounting, a spreadsheet is a large sheet that 
displays a company’s 9nancial position. It shows all 
9nancial information (such as costs, income and 
taxes) on a single sheet for a manager to look at 
when making a decision. An electronic spreadsheet 
organises information into columns and rows. 
1e data can then be manipulated by a formula to 
provide a sum total. 1e spreadsheet can present the 
information in a format to help a decision-maker see 
the 9nancial big picture of an organisation.

You also need to know the location and procedure for the electronic 9ling system for storing 
spreadsheets. 1is is a normal part of using any computer application and it is part of 
workplace protocol. It is important to ensure you store your spreadsheet for easy access by 
yourself and your colleagues. 

Many organisations have speci9c requirements about how data is stored and the way 
it is displayed and presented. Organisations oJen have a style guide that outlines the 
speci9cations and design requirements such as use of headings, particular colours, borders 
and shading, columns and rows. 

You must be aware of these requirements so your spreadsheet meets your organisation’s 
standards. 1ese requirements can relate to how the data is entered, stored, presented and 
produced. 1ese usually have to be completed in a designated time line to meet a deadline. 

Instructions on organisational and task requirements should be used to check that the job 
has been completed correctly.

Purpose, audience and presentation requirements 

Most organisations have requirements for the style in which spreadsheets 

should be presented. 

You need to be familiar with the styles used by your organisation. An organisational style 
guide will explain all the speci9cations and design details. Some organisations use templates 
to ensure the layout and design of a document meets the corporate image of an organisation. 

1e following outlines guidelines on what to consider when determining a document’s 
purpose, audience and presentation requirements. Always refer to your organisational style 
guide for instructions on format and 9nal presentation.  

1B Identifying task requirements and 
selecting the best application
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Purpose

The purpose of a spreadsheet varies and will in�uence the type of document you 

produce and the data used to populate the spreadsheet. Clarify the purpose of the 

spreadsheet before you begin to determine the way it is planned and designed. For 

example, if the document’s purpose is to provide numerical data on sales �gures, you 

may have to collect the information and collate this into the spreadsheet.

Audience

You need to be aware of your document’s audience. Keep in mind who it is intended 

for and decide how the information should be presented. The document’s audience will 

affect how the information is presented. Consider the information needs of the audience 

and how detailed the information should be. A detailed document is likely to have many 

columns and rows, or may extend over several sheets. 

Presentation requirements

How you present your spreadsheet will enhance the audience’s ability to understand 

it. You need to check if there is a template for the task, such as a template for a 

presentation, handout or report. Think about the use of colour, columns and rows, logos 

and formatting requirements.

Following instructions about design and format

There are often guidelines or instructions for producing a spreadsheet, which 

help to communicate an organisation’s professionalism to those outside of it. 

1ese may relate to the content of the spreadsheet or 
its format and layout. 

You may be asked to prepare a report about stock on 
hand and to arrange the data in product code order, 
highlighting the quantity on hand and the quantity 
on order. You may also be asked to cross-check 
product codes with the product description.

1ere are speci9c instructions on how to produce the 
spreadsheet. If these instructions are not followed, it 
may delay the 9nal production of the spreadsheet. It 
may also aBect the accuracy of information.

It is therefore important that care is taken in design 
and layout, and that it adheres to the corporate image of the organisation. OJen, an 
organisational style guide is developed so that there is consistency in the presentation and 
9nal look of the spreadsheets produced right across an organisation. 1is may include using 
standard templates. In many cases, if a standard template is used, prede9ned styles will 
automatically appear in the document. 

Clarify the use of house styles for your organisation with your supervisor and colleagues, 
and ask what the requirements are for the job you are going to undertake before you 
begin. If you have your own ideas on how the content or format of a spreadsheet could be 
improved, speak to your supervisor.
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Why organisational requirements are important

Production guidelines are used to develop time lines and a consistent 

organisational style. 

A time line is used to ensure there is enough time 
to complete the task, edit and review before the 
deadline is reached. A time line is a plan for how 
long a task will take to complete. It also breaks the 
task into steps and details when each step needs to 
be completed by. Your supervisor will oJen provide a 
date, but it will be your job to monitor and report on 
your progress. 

Production guidelines also ensure that documents 
have a consistent style and image so that customers, 
business associates and anyone receiving material 
from your organisation will instantly recognise it 
as belonging to your organisation. 1ese output 
requirements are important because each time a client has contact with an organisation, 
they form an opinion based on the documents they receive. In some instances an 
unprofessional-looking document or one containing errors can be the diBerence between 
gaining and losing a client.

Many organisations have policies and procedures for staB to follow, including style 
guides and templates for producing documents. In larger organisations and government 
departments they are usually clearly de9ned, while smaller organisations oJen have no 
formal documented style guide; instead, staB may be expected to follow examples of 
documents that have previously been produced.

Conforming to organisational requirements will also ensure you are able to complete your 
work in an e
cient and timely manner. It is very frustrating to spend hours working on the 
design of a document, only to 9nd it does not meet requirements. To avoid a situation like 
this, there may be a simple template you could use. Speak to a colleague or your supervisor 
if you are unsure.

Common organisational requirements

Every organisation has di erent requirements for business documents. 

One important requirement is to present an appropriate and consistent corporate image by 
using the organisation’s logo, colour scheme and house style.

Most organisations outline document production procedures and guidelines either in their 
policies and procedures manual or in an in-house style guide. Make sure you know where 
these instructions are kept and that you are familiar with them.

1e requirements appropriate for one organisation may not suit another; for example, a law 
9rm’s requirements would be diBerent from that of a sports equipment retailer. 

To prepare appropriate documents for your organisation, you must follow established 
guidelines and procedures for production.
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Established guidelines and production procedures may include:

 • monitoring the designated time line 

 • adhering to content restrictions

 • using templates

 • including the organisation’s name, time, date and �le name in the header and footer

 • observing copyright legislation

 • delivering the content in the required format.

Selecting a suitable spreadsheet application

The most commonly used spreadsheet software is Microsoft Excel, although 

some organisations prefer to use other programs. 

Some of these applications can be shared and worked on by multiple users at once and 
accessed online. 1is is known as cloud computing. 

1e examples given in this learner guide are based on Excel 2016. Earlier versions will be 
similar in how they work, although there may be some diBerences in the appearance of the 
screens.

1e following table outlines some of the key features of various spreadsheet applications.

Spreadsheet 

software

Key features

Microsoft 

Excel

 • Calculation tools

 • Tools for creating graphs and charts

 • Tools to hide columns, rows and sheets

 • Able to access external data sources

 • Password protection

 • Able to communicate with other Microsoft Of�ce programs, 

including Word and Access

Google 

Sheets

 • Cloud-based, meaning multiple users are able to work in the 

document at once to collaborate on tasks

 • Available as desktop software, online application and mobile app 

 • Keeps track of revision history

 • Uses action items to assign a person to a task

 • The Explore function allows users to search for information online
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Spreadsheet 

software

Key features

Apache 

OpenOf�ce 

Calc

 • Able to summarise and convert raw data into meaningful 

information

 • Formulas can be created using both numbers and words

 • Includes ready-made templates

 • Allows users to forecast results, e.g. based on high or low sales 

results

 • Allows data from multiple users to be integrated

Smartsheet  • Cloud-based, meaning multiple users are able to work in the 

document at once to collaborate on tasks

 • Keeps track of time lines, calendars and task requirements

 • Rows can be expanded to see more detailed notes

 • Each row can have �les and emails attached to it and a discussion 

board linked to it

 • Contains a calendar view and alerts users of upcoming deadlines

 • Can import data from other programs, including Microsoft Of�ce 

and Google applications

 • Available as desktop software or a mobile app

1ere are many organisational and reporting requirements, which will be outlined in 
organisational policies and procedures. 1is information may be used to determine the 
resources available to the company, including the speci9c soJware they can use. Be aware 
of the spreadsheet soJware used in your organisation, and ensure you follow organisational 
policies and procedures. 

Practice task 2

Part A

Question 1 

Explain why it is important that you �nd out information from your supervisor in relation to the 

following before you begin a task:

a. The purpose of the spreadsheet
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b. The intended audience

Question 2 

What can be done to ensure the presentation requirements, such as layout and design of the 

spreadsheet, meet the professional and corporate image of an organisation? 

Question 3 

If you need to collaborate on tasks with your colleagues and work in real time, which of the 

following software applications would you choose? Tick all that apply.

Microsoft Excel

Google sheets

Apache OpenOf�ce Calc

Smartsheet

Part B
Read the case study, then answer the questions that follow.

Case study
Phuong works as an administrative of�cer for a local council. She has recently moved into the 

community development department from the rates department and is looking forward to the 

change. Phuong has been asked by her supervisor to create a spreadsheet report summarising the 

number and type of small businesses in the area, and to include a chart that shows the clustered 

locations of the businesses. Phuong is familiar with using spreadsheets and creating charts from her 

time in the rates department. However, she is not sure how to �nd out the information to include in 

the report – does it mean that she has to go out and visit all the small businesses in the area? 

Phuong decides to speak with her supervisor to clarify what is required to produce the report. 

Phuong’s supervisor explains that it is a report which is completed on an annual basis, so she should 

be able to access last year’s report from the network drive. However, her supervisor is not sure of 

the spreadsheet name, so she will need to a look for it. Her supervisor suggests that she follows 

the same layout and presentation as last year’s report, although she should check that it has the 
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current council logo in the heading. Phuong asks her supervisor who the report is for to check output 

requirements. Her supervisor explains it is to be presented at the upcoming management meeting 

next Friday. Her supervisor has asked that she complete a draft of the spreadsheet by Wednesday 

morning so that he can check the report. Once checked, 15 copies of the report need to be produced.

Phuong goes back to her desk and locates last year’s report. She now knows how it should look. She 

also knows her deadline, the reason for producing the report and how many copies are required. She 

obtains data from another report that was produced by her co-worker last month. Phuong is able to 

use this report as her source document for creating the report she has been asked to complete.

Question 1 

What is Phuong’s task?

Question 2 

What does Phuong do to clarify task requirements?

Question 3 

What additional sources of information were helpful to Phuong in producing the report?
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Storage, output and presentation

Once you have entered data into your worksheet, you need to know what the 

required output is, how it should be presented and where it should be stored. 

For example, your manager may need you to enter monthly sales 9gures, for which a total 
calculation must be made. In this case you need to add a column labelled ‘Total’. You may 
need to format your spreadsheet to match organisational requirements; for example, you 
may need to use a certain font type and size for labels, and precise information in the header 
and footer.

Where you store your spreadsheet depends on who needs the information. When you create 
a spreadsheet, you need to save it immediately. You can save it to your personal hard drive 
or to a shared drive on your organisation’s server. A server delivers information to other 
computers linked by a network. Ask your manager where you should save your spreadsheet 
to ensure you are adhering to company protocols. 

When you start a new spreadsheet, you should think about how you want the spreadsheet to 
present the results, or output, of its calculations. 

Some points about output to keep in mind include:

 • Who is going to use the results?

 • What are the results that will be useful to them?

 • How are they going to use them?

 • What format will they want them in? 

 • What labels should you put on any number results so people can understand what 

they are? 

 • Is the output going to be printed, stored or sent to someone electronically?

Determine and meet time lines

Whenever you are given a work task, you need to determine a time line for its 

completion. 

A time line is a plan for how long a task will take to complete. It also breaks the task into 
steps and details when each step needs to be completed by. Using a diary system and a to-do 
list can help you prioritise tasks and keep on top of the time lines required for set tasks.

In many cases, time lines are set and agreed with your stakeholders – both internal and 
external. Internal stakeholders work in the same organisation as you, and may include 
colleagues in other departments, managers and supervisors. External stakeholders are 
outside of the organisation, including customers and suppliers. 

OJen your manager or supervisor will give you a deadline for completing a task, e.g. prepare 
a spreadsheet by 2pm. Alternatively, you may have deadlines for completing regular work 
tasks, e.g. completing a monthly sales report or a summary of customer contact details. 

Meeting a deadline demonstrates your competency in undertaking tasks as well as your 
professionalism. Make sure that when deadlines are set, they are both achievable and 
realistic.

If you have concerns that a deadline might not be met or you have conIicting priorities, 
discuss this with your manager or supervisor as soon as possible. 1ey may be able to assist 
you by suggesting how the deadline can be met or agreeing to adjust the time line for the task.
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Practice task 3

Read the case study, then answer the questions that follow.

Case study
Josh works as an administrative assistant in a large organisation. One of his duties is to create 

spreadsheets to his manager’s speci�cations. One day Josh is asked to create a spreadsheet 

containing the monthly sales �gures of a selection of products the organisation sells. The 

spreadsheet has to calculate the total takings for each product and then work out a 10 per cent 

taxation charge for each amount calculated.

The spreadsheet must be formatted to organisational requirements and then saved to the server in 

the shared folder for sales. Josh’s manager tells him to name the spreadsheet ‘Product Totals’.

As well as entering the monthly sales �gures in one column, Josh has to create two more columns of 

information.

Question 1 

Describe the information to be held in the two new columns.

Question 2 

How would you label the two new columns?

Question 3 

How does Josh have to format the data?
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Question 4 

What is the name of the spreadsheet and where will it be stored?

Question 5 

Why should Josh speak to his supervisor and con�rm the delivery and time line for the 

development of his spreadsheet?

Summary

• Ergonomics is about creating comfortable working conditions. Setting up a workstation 
to suit your physical requirements prevents undue stress and strain.

• Environmental factors in the workplace, such as lighting, noise and air quality, aBect the 
health of employees.

• Plan daily tasks, rest periods and exercise breaks to prevent repetitive work being done 
for long periods of time.

• Make sure your workstation and working conditions are safe and healthy so you can 
work comfortably and productively.  

• Practise conservation techniques to try to minimise paper wastage and energy use.

• Conserving resources at work bene9ts the organisation by reducing costs, and helps 
to reduce the amount of greenhouse gas produced and the amount of waste going to 
land9ll.

• Spreadsheets are made up of worksheets and workbooks. A worksheet is divided into 
columns and rows, and the intersection of a column and row is called a cell.

• You can change the appearance of your spreadsheet to suit your organisation’s style and 
presentation requirements.

• Task requirements are important because they ensure all the documents produced are:

 − using the best application for the task

 − consistent in style and layout 

 − presenting a consistent corporate image.

• You should always clarify the task requirements before producing your document to 
ensure you create a spreadsheet that aligns with its purpose and meets the needs of the 
target audience.
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Learning checkpoint 1 
Select and prepare resources 

Part A
Write your ideas on how you and your colleagues could improve work practices in relation 
to the following:

a) Work health and safety

b) Identifying potential workplace hazards and risks

c) Conserving energy and other resources
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Part B
Read the case study, then answer the questions that follow.

Case study
Selda has recently started work as a marketing assistant with a large car sales business. She 

has been asked to create a draft summary report of all existing customers, the types of cars they 

have purchased and if they are repeat customers. The information is to come from the product 

sales database. This information will be used to select customers for the marketing campaign for 

the newly released family wagon. The report will be used by �ve members of the marketing team 

and seven sales managers. The marketing manager has asked to see a draft of the spreadsheet 

by the end of the week. The spreadsheet is to be stored on the server in the product folder 

‘PNwagonXXR007’. 

Selda knows she needs to abide by organisational requirements for the design and layout.

1. Explain how Selda would identify the following requirements for the task:

a. 1e purpose of the spreadsheet

b. 1e audience for the spreadsheet

c. 1e data source used for data entry
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d. 1e information to be reported in the spreadsheet

e. 1e number of copies of the spreadsheet required

f. Where to store the spreadsheet

g. How to name the spreadsheet

2. What could Selda do to make sure she meets the deadline for production and delivery of 
the spreadsheet? 
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3. State four possible design requirements that Selda may need to consider when preparing 
the spreadsheet.

4. What should Selda do to con9rm she is using the correct spreadsheet application for the 
task?
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You should know exactly what you need to do and how to do it before you start 

designing and creating a spreadsheet. 

1is helps to make sure that you don’t waste time producing a spreadsheet that doesn’t work 
properly, is hard to use or doesn’t provide the required information.

You may be able to use prede9ned spreadsheets and automatic functions to save time and 
to make sure your spreadsheets comply with organisational standards. 1is makes creating 
and formatting spreadsheets easier – saving time and reducing errors.

When producing a spreadsheet, you should be guided by the requirements of your 
organisation. It is always important to clarify instructions so you are clear about what is 
needed. If you have your own ideas about how the content or format of a spreadsheet could 
be improved, speak to your supervisor.

It is also necessary to check your work to ensure it is accurate, and overcome any design 
Iaws that may have arisen in the process of creating your spreadsheet.

In this topic you will learn about:

2A Entering data and formatting cells

2B Using and testing formulas and functions
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Excel treats data di erently, depending on whether it is 

text, number or date/time.

1e diBerent types of spreadsheet data include:

• text, such as names, addresses and product information

• dates and times

• 9gures such as quantities, prices, sales 9gures and 
interest rates.

Dates 

and 

times

Dates can be entered in the following formats:

 • Day/Month/Year = dd/mm/yyyy

 • Month/Day/Year = mm/dd/yyyy

You need to be clear which format is being used. 

Times use am and pm or a 24-hour format. For example, 6.00pm is the 

same as 18.00. 

Excel 2016 tries to match the formatting with the way the information is 

typed in.

Always con�rm the correct formats for your spreadsheet.

To automatically insert the current date into a cell, select the cell and press 

Ctrl+;

To insert the time, press Ctrl+Shift+;

To automatically put the current date in a cell in the worksheet, you can 

use the TODAY function: 

=TODAY()

Text When entering text, you will notice it is automatically aligned to the left of 

the cell. You will also notice that if there is no data in the adjacent cell, the 

text will over�ow into it.

If there is data in the adjacent cell, the text that is entered will be truncated 

(chopped off). 

2A Entering data and formatting cells
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It may appear that the data is lost, but it is still contained in the cell. 

A simple way to con�rm this is to click in the relevant cell and view the cell’s 

contents in the Formula Bar.

To ensure the printed and on-screen versions of the spreadsheet show 

the cell’s full content, you need to adjust the width of the cell or wrap text 

within the cell. 

Text is commonly used for entries of lists of information such as names, 

addresses and product details.

To wrap text in a cell, select the cells and use the Wrap Text tool , 

which is located in the Home tab.

Wrap Text is commonly used for longer entries where you don’t want to 

adjust the column width, but want to be able to read all of the information 

in the cell, such as address details.

Figures When entering numbers, they will automatically be aligned to the right of 

the cell. In most cases, if the number is longer than the cell, the width of 

the cell will automatically adjust. There is a limit of 15 digits per cell.

Sometimes numbers appear as shown below. This occurs when the number 

has too many digits for Excel to include in the cell, so it rounds it off and 

puts it in scienti�c notation.

When the cell is not wide enough for an entry, it is �lled with a row of 

hashtags (#). This is a different situation to having too many digits.

To correct the problem, adjust the cell width.

You can also use the Number section in the Home tab to increase or 

decrease the number of decimal places shown. It is also possible to make 

number formatting choices such as currency.
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Formatting spreadsheets

There are numerous techniques for improving the appearance of spreadsheets. 

Formatting a spreadsheet eBectively means to present the information in a way that is easy 
to understand. It should also be easy for people to enter data into the spreadsheet.

Before you start planning or designing a spreadsheet, you need to know:

• 1e purpose of the spreadsheet

• Who will use the information

• 1e type of information that needs to go into the spreadsheet (the inputs)

• 1e information that the spreadsheet needs to produce (the outputs)

• How to manipulate and process the inputs to produce the outputs 

Here are some ways that spreadsheets can be formatted.

Formatting 

text

The options for formatting text are very similar to those available 

in word-processing programs. For example, you can highlight 

important text and numbers using bold or italics, underlining or 

shading. You can also adjust the column width or row height and 

adjust the alignment of the text – centre, right, left or angle. You can 

choose how numbers are presented, such as in currency format, 

as decimals with a particular number of decimal places or in date 

format.

Headings Headings in a spreadsheet are the letters above the columns and 

the numbers beside the rows. These headings are useful because 

they give you an understanding of where you are located within the 

spreadsheet. Some people prefer to work without the headings 

displayed. Headings can be turned on and off by selecting the Page 

Layout tab and checking or unchecking the Headings View box.

You can also choose whether to print headings.

Displaying or printing headings is useful when you are checking 

that information has been accurately entered, particularly when 

checking for errors with formulas or functions.

Headers and 

footers

Headers and footers are used to record common information in the 

margin of the report. The header is at the top of the page, while 

the footer is at the bottom. Headers and footers are automatically 

repeated on all pages of the spreadsheet. Headers and footers 

might include the company name and logo, name of the report, 

creation date and �le reference information. 
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Adding and deleting columns and rows

Columns and rows can be easily added or deleted from your spreadsheet.

To add a new column or row go to the Home tab and select Insert. Choose Insert Sheet 
Columns or Insert Sheet Rows from the drop-down menu. A new column or row will be 
inserted adjacent to the cell currently selected. 

To delete a row or column, select Delete. Choose the appropriate option to delete (cell, row, 
column or sheet). If you make a mistake, you can click Undo or press Ctrl+Z.

Using design features to enhance readability and 
appearance 

Styling and formatting spreadsheets can help to highlight key information and 

improve readability and appearance. 

For example, using titles for columns and rows, bold, colour, shading and borders can draw 
the reader’s attention to key information.

Be careful not to overuse styling, which can detract from the data and purpose of a 
spreadsheet to present clear information. 
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Spreadsheet styles and layouts

The layout and presentation of the spreadsheet should project your 

organisation’s image. 

Many organisations use spreadsheet templates to help maintain a standard appearance. 
1ese may have prede9ned fonts, headers and footers, logos, formulas and functions. For 
example, if you are required to produce a monthly report of 9nancial information, the only 
diBerence each month will be the 9nancial data. 1e formulas and overall appearance will 
be the same. Using a template with formulas already developed can save time. You must 9rst 
determine if the formulas are the same as what is required in your current task. 

Templates and style sheets 

A template allows you to create a structure for other spreadsheets using 

common data and formatting options. 

A style sheet is similar to a template and is used to apply prede9ned information, 
formatting, formulas and functions to a spreadsheet. Style sheets can be protected to ensure 
that users cannot change anything apart from the information they are required to enter.

Style sheets and automatic functions are useful tools for ensuring that spreadsheets 
produced by diBerent people in an organisation are consistent in their appearance. 1is is 
especially important if your spreadsheet will appear with others in the same document or 
presentation. 

You can create a template from a blank workbook. Templates can also be accessed by 
selecting New from the File tab.

To do this, create the spreadsheet component or structure you want to use, then select the 
File tab and choose Save As. Give the template an appropriate name, and use the Save as 
type drop-down menu to select ‘Excel Template’. 

If you are working in Excel 2016 and the template is to be used by people who have an older 
version of Excel, you may need to choose the option ‘Excel 97-2003 Template’.
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Some of the features you can incorporate into your style sheets are:

• borders

• page numbers

• alignment

• font styles and point size.

Borders

Borders are lines applied around a cell or groups of cells. 

Borders are used to keep certain information separate from other parts of the spreadsheet or 
to highlight key information. 

To add a border, select the area where you want the border to apply. Select the Home tab and 
use the Borders drop-down menu to select the appropriate border. For more speci9c styling 
options for borders, select More Borders, which allows you to select a style and choose 
which parts of the cell to apply it to.
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Headers, footers and page numbers

Headers and footers are used to incorporate information into the margin of a 

spreadsheet. 

Examples include current date and time, 9le reference, and page numbers. 

To insert a header or footer click on the Insert tab and select Header & Footer. You will 
now be able to enter the required information or use the tool buttons to design your header 
and footer. AJer entering a header or footer, the onscreen view will change to Page Layout. 
To return to the normal view, select the View tab and click Normal.

Page numbering is commonly used in either the header or footer of the spreadsheet to show 
the total number of pages and the current page you are viewing in the printed version. 
To insert page numbers, select Header & Footer from the Insert tab. 1e Design tab will 
appear, then you can select the appropriate page numbering tool as shown below.

If you are showing both current page number and total number of pages, you need to 
manually type in ‘of ’ as this is not automated.

Alignment of text and values

Text and values align di erently within the cell by default. Text aligns to the 

left, values to the right. 

To adjust the horizontal alignment of data in a cell, select the cell and choose the 
appropriate alignment tool from the Home tab. 

Horizontal alignment options include leJ, centred and right. Data can also be aligned to 
the top, centre or bottom of the cell. In addition, text can be oriented to be vertical or on an 
angle. 1is can be helpful to 9t lengthy headings on the side of tables.

Another common tool used to align cells is Merge & Center. 1is is commonly used to 
align a heading across the width of data in the spreadsheet. When using Merge & Center, 
the data to be merged across the cells must be in the 9rst cell selected.
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Look at the following example.

In this example, the headings ‘Henry Lewis Consulting & Co’ and ‘Sales results’ have been 
merged and centred across the columns A:G. To perform this action, each row is dealt with 
separately. First, the data from cells A1:G1 are selected and then the Merge & Center tool 

 on the Home tab is clicked. Next, the data from cells A2:G2 is selected, and 
then the Merge & Center tool is clicked. 1is provides the data with a heading.

Extra space can also be added to the spreadsheet by adjusting the column width and row 
height. 1is can be done by positioning the cursor between either the letters of the columns 
to be widened, or the numbers of the rows to be made taller. A double-headed arrow will 
appear that will enable you to click and drag to adjust the column width or row height. 

Typeface styles 

Many organisations have standard requirements for font type and size. 

To adjust the font, select the cell to be changed and make your selection using the Font tool 
and Font Size tool.

In MicrosoJ Excel 2016, it is possible to use styles to format cells. Styles apply formatting 
such as colour, borders, font type and size to the cell.

To do this, select the cells to be formatted by highlighting them. To format using styles, 
from the Home tab, select Cell Styles and choose an option.
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Default settings are the original settings of the spreadsheet, referred to in Excel as the 
Normal style. 1is style has preset formatting such as font type=Arial, font size=12. 1ere is 
no other formatting applied to the Normal style. To adjust data to the Normal style, select 
cells to be adjusted, and from the Home tab, then select Normal  in the Styles 
section.

Table headings

In Excel 2016, it is possible to convert your data into a table. 

Tables make the information easy to work with, as formatting is automatically applied and 
it is possible to have the titles of the table automatically become headings. 1is can be useful 
for sorting and reviewing data. 1e following example demonstrates how data has been 
converted to a table format with headings.

1e table headings have arrows that enable you to quickly sort the data.

To convert data to a table, select the cells by clicking and dragging to highlight them, then 
select Table from the Insert tab.

Cell styles

The use of styles will add to the appearance and overall presentation of 

information.

In MicrosoJ Excel 2016, there is an option to apply cell styles to the spreadsheet. 1ese are 
prede9ned styles available for you to use. Styles relate to font type, font formatting, number 
formatting, borders and shading. Simply select the cells that require the style applied, 
choosing the Home tab, and select the Cell Styles button. From here you can choose to 
apply a prede9ned style or create a new style for future use.

You might choose to use diBerent prede9ned styles for row and column titles, the data 
contained in the spreadsheet and summary information. 

1e following example shows how style choices can be used to improve presentation. 1e 
spreadsheet titles are formatted, merged and centred across the length of the data. Titles are 
formatted appropriately and end stock 9gures are shaded to highlight the end result. 



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

41

Topic 2
Design and create spreadsheets

Keyboard shortcuts 

Keyboard shortcut commands are useful for speeding up data entry and 

formatting processes. 

It is possible to create macros to make your own keyboard shortcut commands for common 
actions, such as inserting a company logo. 

Common keyboard shortcut commands include:

 • Ctrl+B to make selected cells bold

 • Ctrl+I to make selected cells italic

 • Ctrl+C to copy selected cells

 • Ctrl+X to cut selected cells

 • Ctrl+V to paste selected cells

 • Ctrl+F to activate the Find function

Many other keyboard shortcuts are available. 1ese are explained in Excel’s help function. 
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Practice task 4

Consider and compare these two spreadsheet examples. 
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Question 1 

What are the differences between the two examples?

Question 2 

Which one is easier to read? Why?

Practice task 5

1. Create the following spreadsheet and apply borders as shown – thin inside borders for 
key information, and a thick outline border for the entire report. Save the 9le to an 
appropriate 9le location and name it ‘August Car Sales’.

Adjust the column width and row height to give more space. Adjust the alignment 
within cells to improve the presentation of the data. Start by centring vertically and 
horizontally.

Format text by using diBerent font types and sizes and bold or italics.

Use colour and shading to format cells.
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2. Use the information in the table below to create a spreadsheet that meets these 
requirements:

• Font: Arial 14, bold and italic

• Titles: shade background in yellow

• Border: thick outline

Save the 9le to an appropriate location and name it ‘Fashion Excess – stock on hand’.

Stock item Quantity on hand Cost per item Retail price 

per item

Knickerbockers 188 $45 $86

Flower power 

pants

191 $55 $92

Flare pants 192 $51 $98

Skirts 101 $18 $67

A-line skirts 76 $23 $87

Hot pants 177 $34 $76

3. Create the following spreadsheet and convert it to a table with headings. Practise using 
the heading arrows to sort and review the entries. 
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Page Layout view

The Page Layout view is used to quickly and easily make adjustments to the 

worksheet. 

Use this view to adjust the layout and format data as appropriate. It is possible in this view 
to change the orientation of pages, adjust headers and footers, and adjust margins, column 
width and row height. 1is view includes row and column headers and has a ruler for 
measurement. 

To select this option, go to the View tab and select Page Layout. Adjust margins by 
positioning the cursor on the margin line in the ruler so it is a double arrow, then click and 
drag. 1e same process can be followed to adjust row height and column width. To adjust 
the header or footer, simply click into the entry and make appropriate changes. Orientation 
can be changed from portrait to landscape, and vice versa, by selecting the Page Layout tab 
and clicking on Orientation.

Page alignment 

The page alignment can be adjusted to ensure that content is evenly distributed 

on the page.

When creating spreadsheets, it is best practice to begin your spreadsheet at cell A1. What 
occurs, however, is that when you print the spreadsheet, the information begins at the upper 
leJ of the page. 1is is reasonable for presentation of a longer report but if it is a shorter 
report, the spreadsheet will seem to be crammed into one corner. Look at the following 
example of page alignment.

To adjust the alignment so the information is centred in the page, follow these steps:

From the File tab, select Print, then select Page Setup at the bottom of the Settings panel. 
Select the Margins tab. Under Center on Page tick both Horizontally and Vertically. 
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1e Page Setup dialog box also provides a preview of your changes.

Proo1ng and AutoCorrect

AutoCorrect automates the proofreading process so that common errors or 

entries are easier to detect and 5x. 

AutoCorrect automatically corrects common typing errors; for instance, if you were typing 
the word ‘what’, and accidently typed in ‘whta’, Excel will correct the error to ‘what’. It is a 
handy feature, but only works for common words. 

1e Proo9ng feature can be customised by selecting the File tab, choosing Options and 
selecting Proo,ng. Here you can select options such as Ignore words in uppercase and 
Ignore words that contain numbers. You can also click AutoCorrect Options and type in 
commonly misspelled words and what they should be replaced with.
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To check errors in labels, select Spelling under the Review tab. 1is identi9es misspelt 
words. However, it cannot assist with product names, customers’ names or addresses. 
Manually check your spelling and crosscheck it with the original data source. For example, 
you may have been given a printout of all customers’ names to be entered. Once you have 
entered the customers’ names, check them for accuracy against the printout.

You should check all information, including:

 • name and address details

 • spelling

 • product information and pricing

 • dates

 • reference details; for example, catalogues and previous correspondence.

AutoText 

AutoText completes text as you type. 

Excel recognises that you may have entered the same information previously. For instance, 
you may be typing in locations of retail outlets, such as Sydney, Melbourne and Adelaide. 
Once you have typed in these entries, when you type the data for the next entry, Excel will 
automatically provide an option for you to select from rather than retyping. Look at the 
example below:

In this example, as soon as ‘M’ is typed, it automatically completes the text to say 
‘Melbourne’. It is then only necessary for you to press enter to accept it. If it is another entry 
that you are completing – such as Malvern – just continue typing.

Importing and exporting data

You may want to bring data into your spreadsheet from another application 

such as Microsoft Access. This is called importing data. 

For example, if the information you require is stored in a customer database, you may need 
to import customers’ contact details and other information.

1e following tools, located in the Data tab under the Get & Transform Data section, are 
used to import data.
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Exporting data to another application from Excel can be done by copying and pasting 
the required information. You might need to do this if the data needs to be analysed or 
presented in a diBerent way.

Practice task 6

Here is a spreadsheet and the original information used to create it.

Customer accounts worksheet

Customer documentation

Customers Balance

Smith 55.00

Carter 4,000.00

Andrews 3,455.00

Phillips 3,000.00

Elliot 2,500.00

Franks 5,000.00

Luie 34.00

Question 1 

How many errors are in the spreadsheet?
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Question 2 

What are the consequences of numeric values being entered incorrectly?

Question 3 

What should customer Smith’s balance be?

Question 4 

Create the worksheet with accurate information. Save it to an appropriate location, and call it 

‘Customer Accounts’.

Practice task 7

Open the spreadsheet called Customer Accounts you created in Practice task 6. 

• Go to Print to see how the spreadsheet will look when printed. 

• Adjust the page alignment so it is centred on the page both vertically and horizontally. 

• Check with Print Preview.

• Practise inserting and deleting columns and rows. Don’t save the changes you make. 
You can also practise changing cell widths.

• Use the Help function to investigate keyboard shortcut commands available in Excel. 
Search for Excel shortcut and function keys. 

• Practise using some of the shortcut keys to change the format of the spreadsheet.
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Formulas and functions are at the heart of a spreadsheet. They take your data 

and manipulate it in various ways to give the outputs needed.

Functions are a type of formula that performs more 
complex calculations. Perhaps the simplest of these to 
understand is the SUM function, which is a complex 
form of adding values from a range of cells together.

Excel uses formulas and functions (built-in formulas) 
to manipulate numbers so you can analyse them 
however you need to.

Some typical ways a spreadsheet can make analysis of 
data quick and easy are by:

• calculating the average of numbers

• calculating the totals of a list of numbers

• working out percentages

• calculating simple and compound interest using formulas.

You can enter a formula into any cell. To do this you must start with an = sign so the 
spreadsheet knows that it is a formula.

The most basic operations a formula can do are:

 • add using the + symbol 

 • subtract using the – symbol 

 • multiply using the * symbol

 • divide using the / symbol 

If you want to add two numbers enter the 9rst number into a cell (such as A1), then enter 
the second number into another cell (such as A2). Type a formula into another cell. For this 
example, type =A1+A2 into cell A3. When you press Enter on the keyboard, the answer to 
the calculation will be displayed in cell A3.

If new numbers are typed in A1 and A2, cell A3 will automatically display the new answer 
when Enter or an arrow key is pressed. 1is means you don’t have to type the formula all 
over again; it stays there, processes the data from A1 and A2, and records the result in A3.

Functions

A function is a formula that is built into a spreadsheet. 

Functions can save a lot of eBort by doing quite complex calculations in one cell. Excel 
provides functions to do a variety of common calculations, such as SUM or AVERAGE. 
For example, =SUM(B5:B17) adds all the numbers in the range of cells from B5 to B17. 
Functions can be used in Excel to perform a variety of mathematical, statistical and 
9nancial calculations to help you to analyse information. Some common functions used in 
Excel are shown in the following table.

2B Using and testing formulas and functions
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=SUM(range) Adds the numbers in the cells that are within the range speci�ed 

in the brackets.

Example: Calculates the total sales �gures for a given period.

=MAX(range) Finds the highest value from cells that are within the range 

speci�ed in the brackets.

Example: Shows the highest student result from the group.

=MIN(range) Finds the lowest value from cells that are within the range 

speci�ed in the brackets.

Example: Shows the lowest student result from the group.

=AVERAGE(range) Finds the average of numbers in the cells that are within the 

range speci�ed in the brackets.

Example: Shows the average result of all students.

=COUNT(range) Counts the number of items in the range.

Example: Counts the number of results entered for the class.

Automatic functions

If you have created a formula in one cell, and you want to repeat it in additional 

cells, you can either copy it or use automatic functions.

AutoFill is used to repeat sequenced information that aligns with the selected cell. Use the 
AutoFill handle  to repeat the sequence of formulas and functions. 

AutoSum enables you to add values automatically using the SUM function. Select a range 
of values that you want to calculate and select AutoSum, which can be accessed from the 
Home tab.

Checking and amending data

Once data has been entered in the spreadsheet, you need to check that it is 

correct, and 5x any errors that exist. 

If the information contained in the spreadsheet is not accurate it 
will cause problems for others and reIect poorly on the company 
you represent. For example, you might mistype the 9gures 
in a summary of house sale prices. Taking the time to check 
information and making sure it is correct helps to save time, 
improve e
ciency and increase customer and organisational 
satisfaction.

Remember, if your input is wrong, your output will also 
be wrong.

Producing spreadsheets requires you to follow instructions. Instructions may be given 
by your manager or supervisor, the person requesting the spreadsheet, past spreadsheets 
or instruction manuals. Instructions may relate to the spreadsheet’s content or its format 
and layout. For example, you may be asked to produce a sales report summarising weekly 
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9gures, and provide a comparison of actual results with target results. You may be required 
to identify sales personnel and specify their performance in terms of actual and target 
performance. 1ese instructions provide guidance on what is required for the report and 
how it is to be produced.

If instructions are not followed, it may delay the 9nal production of the report, or reduce the 
usefulness, meaning and credibility of the information. If you need to clarify instructions, 
or have your own ideas about how the spreadsheet could be improved, speak to your 
manager or the person requiring the information.

Testing formulas and functions 

In complex spreadsheets, there might be several possible answers, depending 

on the order in which calculations are carried out.

You should input test data and use a calculator to work out what answers your spreadsheet 
should give. For instance, if your formula is meant to give the average of 9ve numbers 
in cells B1 to B5, then make up some numbers and put them in the spreadsheet. Add up 
the same numbers on a calculator, then divide by 9ve to see if you have the same answer 
produced by the formula. If not, you have probably made one of the following mistakes: 

• typing in the wrong cell reference in a formula (such as B11 instead of B1)

• making a mistake when typing the formula (such as typing + instead of *)

• using the wrong formula.

It is important to always check your spreadsheet for accuracy. 1is may include double-
checking with your colleagues or manager to make sure the data you have entered is correct. 
As well as checking the values you have entered, you should also ensure that any labels are 
spelt correctly and that you have formatted all data to suit organisational requirements. 

You may be able to give the information you produce to a colleague or supervisor to check 
in draJ form before you complete the 9nal version. 

Use the Show Formulas tool 
 
in the Formulas tab to review formula 

entries.

Check the spreadsheet to ensure:

 • the accuracy of data entered

 • formulas are working correctly

 • all instructions have been followed

 • the design and layout are consistent.
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Practice task 8

Read the case study, then answer the questions that follow.

Case study
Helen has recently taken up a position as an administrative of�cer with a government department. 

Her manager asks her to compile a spreadsheet report analysing the number of people who have 

travelled overseas in the past year, as well as information on countries visited. She has also been 

asked to ensure that she follows standard guidelines for producing the report such as use of 

corporate colours, font type and size and the company logo. The report from the spreadsheet is to 

be distributed to media outlets. A graphical representation showing the top 10 locations for travel is 

also required.

Question 1 

Who is the audience for the spreadsheet?

Question 2 

What is the purpose of the spreadsheet?

Question 3 

What are the information requirements?

Question 4 

What are the elements of spreadsheet design that Helen needs to consider?
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Error alerts

Excel has many features to help you identify errors, such as an inconsistency in 

a formula. 

In the following example, a small arrow in cell F6 indicates there is an error in the formula.

If you select the cell with the alert, a help bubble will appear that explains the error that 
Excel has identi9ed.

If you are unsure what the error is, you can also use Formula Auditing tools in the 
Formulas tab to investigate errors and determine what action needs to be taken to 
correct them. 

Another useful feature is the Trace Precedents tool, which shows a diagram of where the 
data in the calculations comes from. To use this tool, select the cell that contains the error 
and then select Trace Precedents in the Formulas tab. 1e spreadsheet will show preceding 
connections, as in the following example.

It may also be necessary to consult with colleagues, your manager or the person who has 
requested the spreadsheet to con9rm the results of the formula. If the results don’t appear 
to be correct, take appropriate measures to check the entries. 1is includes checking 
calculations as well as source data. If you are still in doubt, seek advice from your manager 
or colleagues.

If you 9nd there is no error in the formula indicated in the warning message, you can 
choose Ignore. 1is will remove the green error Iag from the spreadsheet.
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Absolute and relative cell addresses 

Relative references change when you copy and move cells, whereas absolute 

references don’t.

1e cells in an Excel spreadsheet are all relative to each other. 1is means that if you place a 
value in one cell and then move it, the values will alter as the cell collects information from 
other cells around it. For example, the totals you calculated for each of your columns may 
need to be moved to another part of the spreadsheet. However, if you move the totals values 
to another location, the values would alter as the cells are no longer reading information 
from the cells immediately above them. 1is kind of reference is called a relative reference.

1is can be very important if you shiJ a formula, because you may need to decide if the 
cell references in it should stay the same (absolute references) or stay in the same relative 
position (for instance, always one cell above the formula).

To make the values remain the same wherever you place them in the spreadsheet, you need 
to make the reference absolute. To make a cell reference absolute, use $ in the reference, such 
as in the following examples:

=C5+B5 is a relative reference.

=$C$5+$B$5 is an absolute reference.

Practice task 9

In this exercise you are going to create a formula to calculate the values for the 
Pro9t column.

1. Create a spreadsheet named ‘Warehouse Pro9t’ using the data below.

2. Create a formula to calculate the pro9t. Ensure you use the cell references and not the 
actual numbers in the cells. Select cell D4 and enter the formula =B4–C4. Press the 
Enter key to perform the calculation.
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Once you have a calculation, use AutoFill to repeat the calculation in the remainder of 
the column. Your worksheet should now look like the following example.

3. 1e tax values need to be calculated as 10 per cent of the pro9t. In cell E4, enter the 
formula =10%*D4 (this will give you 10 per cent of the value in D4). Press the Enter key 
to perform the calculation.

Use AutoFill for the remainder of the column. 

4. Select cell F4 and enter the following formula =D4–E4. 1is calculation subtracts the 
Tax from the Pro9t, giving you an End Pro9t value. Press the Enter key to perform the 
calculation.

Use AutoFill for the remainder of the column. 

5. Open your Warehouse Pro9t spreadsheet. Select cell B10. From the Formulas tab select 
Insert Function. You will see the following dialog box. Select SUM and click OK.
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6. As you have selected a cell at the end of a column full of numeric values, the SUM 
function is going to add all of these values together. Number 1 shows the formula the 
SUM function will use to make the calculation and the formula result is displayed at 
the bottom of the dialog box. Click OK. Cell B10 should now hold the calculation of all 
Income values added together.

7. Repeat step 6 for the following cells: C10, D10, E10 and F10. Your worksheet should now 
look similar to the following example. 

Practice task 10

Enter the following data into a new spreadsheet.

1. To calculate the January commission, enter the formula =B3*C3 in cell D3. Press Enter 
then use AutoFill to complete the column. Save the 9le as ‘January sales commissions’.

2. Label row 8 ‘Highest commission’. Select AutoSum, then MAX to calculate the highest 
commission for January. Ensure the range is set to (D3:D7).

3. Label row 9 ‘Lowest commission’. Select AutoSum, then MIN to calculate the lowest 
commission. Ensure the range is set to (D3:D7).

4. Label row 10 ‘Average commission’. Select AutoSum, then AVERAGE to calculate the 
average commission. Ensure the range is set to (D3:D7).

5. Label row 11 ‘Total commissions’. Under the Formulas tab, select AutoSum, then Sum 
to calculate the total of the January commissions. Ensure the range is set to (D3:D7).
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Common problems when producing spreadsheets

It is inevitable that problems will arise when designing and producing 

spreadsheets. 

Fortunately, there are many resources to help you overcome them, including referring to 
the Excel help function, training manuals and instruction guides. You may also be able to 
obtain assistance from colleagues or managers. If the problem is still unresolved, you may 
need to seek specialist help from your organisation’s IT staB.

1e following table shows common problems that occur when producing spreadsheets.

Problem/issue Example Action to take to 

correct the problem

Data entry is 

incorrect

 • Misspelt names

 • Incorrect �gures

 • Missing data or information

 • Check spelling

 • Proofread and check 

spreadsheet data

Text over�ows 

or truncates

 • Text entry �ows into adjacent cell

 • If an adjacent cell contains data, text 

appears to truncate

 • Adjust column width

 • Apply Text Wrap to the cell

Text not in full 

view

 • Adjust row height

 • Align content to the top of 

the cell

Numerical 

entry has too 

many digits

 • Use fewer digits in the cell (if 

possible) – there is a limit of 

15 digits per cell 

Date 

formatting not 

consistent

 • Adjust date formatting to the 

same format throughout

Number 

displayed as 

###

 • Adjust column width
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Problem/issue Examples Action to take to 

correct the problem

Cell alignment 

not consistent

 • Adjust alignment of cells – 

both vertical and horizontal

Incorrect 

calculation 

result

 • Check formula or function 

inputs

 • Check data entry

Result of 

calculation 

appears with a 

#VALUE! alert

 • Check formula or function 

input – this alert appears 

when a cell containing letters 

is included in a calculation

Green error 

alert

 • Click on the green alert – a 

message will appear to 

explain the possible problem 

 • Investigate error and make 

necessary corrections

 • Use the warning menu to 

make appropriate choices 

Investigation 

into possible 

errors in 

results needed

 • Use the Formula Auditing 

tools to track the formula 

– this can only be used if 

the formula has been input 

using cell references such as 

=A1+A2
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Help resources 

Working with software applications can be quite complex and there may be 

times when you need to seek assistance. 

Excel has a built-in help function, but if you cannot 9nd the answer there you may need 
to seek the advice of an experienced Excel user such as a supervisor, colleague or IT 
support person.

Here are some other avenues you can access when you need help.

Manuals and training 

Your organisation may have task- or role-speci�c manuals to 

help you produce spreadsheets. These provide guidance and 

assistance on the types of information a spreadsheet should 

contain or may specify the instructions to be followed for 

formatting and designing spreadsheets. 

Excel software comes with user manuals that describe the 

software features and provide step-by-step instructions for 

carrying out different functions. You can �nd manuals in 

paper-based and online formats. 

You may have been to a training course to learn a particular 

computer function. Training courses usually provide a 

comprehensive set of instructions or notes that are worth 

keeping for future reference.

Online help

You can �nd information about Microsoft Of�ce applications 

on many different websites. These often contain frequently 

asked questions and solutions to common problems. You 

can also download updates, tools and any �xes Microsoft has 

developed for software problems. You may �nd the following 

websites useful:

 • http://aspirelr.link/microsoft-support

 • http://aspirelr.link/microsoft-of�ce

Tool buttons

Each time you move your mouse pointer over a tool button 

and leave it there for a moment, it will display a tip that tells 

you what the button is used for. For instance, from the Home 

tab, move your mouse pointer over the Font tools. You will 

notice the help tip for the Font Colour tool button.



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

61

Topic 2
Design and create spreadsheets

Practice task 11

Read the case study, then answer the questions that follow.

Case study
Chinh works as an administrative assistant in a small manufacturing organisation. One of his tasks 

is to create Excel spreadsheets for his supervisor.

When creating spreadsheets Chinh often needs to use Excel help to answer questions about 

software functionality. If he is unsure of a screen icon’s function, he presses Shift+F1 and points to 

the icon with his mouse.

Recently, Chinh attended a two-day Excel training course at a local community centre. He keeps 

the training booklet they handed out on his bookshelf. It has a handy index at the back for quick 

solutions to problems. He has also photocopied pages from various manuals he found around the 

of�ce and has placed them in a help folder on his desk.

Sometimes Chinh experiences software function problems that cannot be easily solved. Chinh then 

uses Microsoft’s support website to �nd a solution, or he refers to the paper-based material he has 

gathered.

Question 1 

If Chinh experiences software functionality problems, where does he go for help?

Question 2 

Describe how Chinh uses paper-based manuals for help.

Question 3 

If you experience a software problem when creating a spreadsheet, describe the steps you 

should take to solve the problem.
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Summary

• Spreadsheets are used to analyse data and present the results in a clear and 
comprehensive way.

• When designing a spreadsheet you need to know its purpose, who will use it and the 
inputs, processing and outputs required.

• 1e design of the spreadsheet should meet the needs of the person requesting it, as well 
as organisational expectations and standards.

• You can use formatting, charts and other graphics to improve the readability and overall 
presentation of the spreadsheet.

• Formulas and functions simplify the processing of data.

• Automatic features can be used to save time and reduce errors.

• Spreadsheets should be consistent in design and layout.

• Spreadsheet design and layout must adhere to organisational and task requirements.

• Text, numerals, date and time, formulas and functions can be entered into a 
spreadsheet.

• It is important to proofread and check spreadsheets to ensure accuracy of the end 
product.

• Formatting options provide a means to improve the readability and design of 
spreadsheets.

• Formulas and functions allow repetitive calculations to be done automatically. All the 
user has to do is change the data.

• Excel has a number of ways to identify and correct errors in a worksheet.

• 1ere are many ways you can get help, including referring to manuals, help desks and 
online support.
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Learning checkpoint 2 
Design and create spreadsheets

Part A
Read the case study, then complete the tasks that follow.

Case study
You work as an administrative of�cer for Eastern Employment Agency. The marketing manager asks 

you to create a spreadsheet to be used as a summary report to promote their achievements in work 

placements. Information is to be presented to show weekly results as well as monthly achievements 

of the past quarter. The weekly information for the report is as follows:

Week ending Client 

numbers 

at start of 

the week

New 

clients

Number 

of clients 

placed 

in work

Number of 

voluntary 

placements

Number 

of paid 

placements

7 January 5038 123 1231 402 829

14 January ? 234 1234 341 893

21 January ? 12 435 123 312

28 January ? 43 1121 455 666

5 February ? 341 341 23 318

12 February ? 121 234 28 206

19 February ? 12 432 231 201

26 February ? 42 123 53 70

5 March ? 411 532 43 489

12 March ? 123 522 234 288

19 March ? 12 100 50 50

26 March ? 234 123 12 111
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To comply with your organisation’s requirements you must:

• insert a header stating the name of the business

• insert a light blue background shading  

• use a thick outline border and a thinner line for inside borders

• bold titles

• use Arial font type 

• use size 14pt font. 

1. Create a report of the weekly results and calculate the client numbers at the start of each 
week. 

2. Use appropriate cell references to complete the calculation. 

3. Calculate as follows: 

Client numbers at start of week = number at start of previous week + number of new 
clients – number of clients placed in work

4. Create a monthly summary report as requested by the marketing manager. Use the 
SUM function to calculate summary 9gures for each month. 

5. Save the 9le to an appropriate location and name it ‘Work placement summary’. 

Part B
Read the case study, then complete the tasks that follow.

Case study
Mara works as an employment coordinator for Eastern Employment Agency. She has been asked to 

produce a monthly summary report for the operations manager to present at the next management 

meeting. The report is to show the number of paid work industry placements. The information will be 

used to analyse market segments. 

Organisational style requirements for the spreadsheet are as follows:

• Header stating the name of the business

• Light blue background shading 

• 1ick outline border and a thinner line for inside borders

• Bold titles

• Arial font type 

• Size 14pt font

Mara produced the following spreadsheet for the operations manager.
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1. What is the purpose of the spreadsheet?

2. Who is the spreadsheet for?

3. What are the task or information requirements for the spreadsheet?

4. What are the organisational requirements for the spreadsheet?

5. Has Mara produced a spreadsheet that conforms to the organisational and task 
requirements?
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6. What could Mara do to improve the overall readability and appearance of the 
spreadsheet?

7. How would a style sheet help Mara?

Part C
Read the case study, then answer the questions that follow.

Case study
Gabby works for a market research �rm as a research assistant in the product testing department. 

One of their recent projects has been to undertake a focus group to analyse and evaluate the 

possible launch of a new ice-cream into the marketplace. The spreadsheet summary results should 

look similar to the following.



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

67

Topic 2
Design and create spreadsheets

Gabby is required to do the following:

 • enter all result data using the prede�ned style (template)

 • use the AVERAGE function to analyse overall ratings.

Gabby is new to using Excel, and isn’t sure how to access and use the style sheet. She knows how to 

use the SUM function, but isn’t sure about the AVERAGE function. 

Gabby decides to produce a spreadsheet that contains all the relevant information and presents that 

to the product manager. Gabby’s spreadsheet looks like this.

1. What mistakes has Gabby made in the production of the spreadsheet?

2. What should Gabby have done to proof and check the spreadsheet?
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3. If Gabby thought there was a problem with the results of the calculations, what could 
she have done to check it?

4. What should Gabby have done to 9nd out about style and the AVERAGE function?
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A chart is a graphical representation of selected worksheet information. 

Charts are used to visually represent numerical data and make it easier to highlight changes, 
compare 9gures and spot trends over a period of time.

1e type of chart you use will depend on the type of data you are analysing; for example, 
you could choose a pie chart to show a single set of data and a column chart to show 
multiple sets of data.

You must format a chart in line with organisational and task requirements. Formatting a 
chart improves the presentation and readability of the information.

In this topic you will learn about:

3A Selecting an appropriate chart type and design

3B Creating and modifying charts
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When producing charts, it is important to follow both organisational and task 

requirements. 

An organisation may have a set preference for the types of charts it uses. For example, it may 
prefer to use column charts as opposed to line charts because they make it easier to analyse 
the information. An organisation may also use certain colour codes for the presentation 
of data; if this is the case, these rules should be followed to ensure the organisation’s image 
remains consistent.

Task requirements can depend on a set of instructions and protocols for producing charts. 
You may be asked to prepare a summary report of monthly sales as well as a chart. If this 
is the case, you may need to produce two separate documents. If the policy is that a certain 
type of chart design is used for the production of various reports, you need to do this. 

If you have any suggestions for improving the readability and analysis of charts and their 
associated data, discuss them with your supervisor or manager.

Types of charts and their features

Charts are visually appealing and make it easy to see data and absorb 

information at a glance. 

1e types of charts you can select include: 

• area 

• bar

• column

• pie

• line 

• scatter.

Charts are a good way to show the results of the spreadsheet analysis because they can be 
grasped quickly, without the user having to do too much thinking. For example, a pie chart 
or a bar chart could be used to show what percentage of total sales each of several models of 
cars contributes. To show how the temperature in a coolroom varies over several weeks, a 
line chart or a scatter chart would be best. 

1e kind of chart you choose and its design should reIect your organisation’s needs and the 
task requirements. 

1e following example shows the percentages of types of cakes sold in a bakery presented 
in a pie chart. It is easier to look at the cake shop data in a chart rather than looking at the 
9gures in a worksheet.

3A Selecting an appropriate 
chart type and design
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Charts in Excel are linked to information contained in the selected cells. 1is means that if 
the cell data is updated, the chart is also updated.

Area chart

Area charts can be used to demonstrate changes over time. 

For instance, they may be used to compare changes to sales over the past 12 months. 

1e following example shows how yearly real estate sales 9gures vary for diBerent outlets.

Bar charts

A bar chart displays information as a series of horizontal bars. 

1ese charts are useful for comparing data arranged in columns or rows. Bar charts show 
the diBerences between individual items.

1e following example shows how monthly sales vary for diBerent departments of a 
retail outlet.
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You can use a stacked bar chart to compare the values of individual totals to a total across 
multiple categories. 

1e following example compares monthly department sales 9gures, as well as the total 
overall amounts for the sales quarter.

Column charts

A column chart has vertical columns and is useful for comparing separate types 

of data from a data series. 

1e following example shows how rainfall data in Sydney and Melbourne can be compared 
using a column chart.
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If you prefer the 3D look for your column chart, choose 3D when making your chart 
selection.

You can use a stacked column chart to compare the values of individual totals to a total 
across multiple categories. 

1e following example compares monthly rainfall for Melbourne and Sydney, as well as the 
total overall amount.

Pie charts

A pie chart shows a data series in percentage segments. 

It is useful for showing data as a percentage of a whole. Pie charts are commonly used to 
show which products are selling or how much market share an organisation has. 

1e following example of a two-dimensional pie chart shows the market shares of 9ve health 
food companies.
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If you prefer the 3D look for your pie chart, choose 3D when making your chart selection.

Line chart

A line chart shows the movement of values in a data series using single or 

multiple lines. 

It is useful for showing how the values of a data series can change over a period of time. 

1e following example uses a line chart to compare total monthly rainfall in Melbourne 
and Sydney.
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Scatter chart

A scatter chart is used to compare and arrange data to analyse the 

relationships between numerical information. 

A scatter chart displays clusters and is commonly used for statistical comparisons. 

1e following example uses a scatter chart to display and analyse estimated and actual sales 
results. 

Practice task 12

Question 1 

Using this table, note what type of chart would be best for displaying the information and explain 

why.

Data to be included 

in a chart

Type of chart used Reason

Percentage of actual 

sales for individual 

product items

Pro�t for individual retail 

outlets compared with 

last year

Comparison of workplace 

hazards identi�ed in the 

organisation

A chart to show changes 

in workplace hazard 

identi�cation over a given 

period of time
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Read the case study, then answer the question that follows.

Case study
Juicy Fruits is a fruit supplier specialising in fruit baskets for corporate organisations. At the end 

of each month, a report is compiled tallying all the fruit supplied. Information reported on includes 

product type, number of products supplied and sales �gures. 

Julian Ali, the business owner, is happy with the reports, but realises that some of the supply 

coordinators are �nding the information cumbersome to interpret. Julian decides that in addition to 

the reports, he would like to trial preparing the information in chart form to compare the supply data 

of each of the products. He believes that a graphical representation of the data will be easier for the 

coordinators to decipher and compare. 

As the administration supervisor, Julian has asked you to prepare an example of how the data 

would be presented in chart form. Julian has asked that you use bright colours in the charts as this 

complements the style and colour range of fruit types supplied by the business. He has also asked 

that you present the information in column form with product supply numbers and product types 

identi�ed in the chart. It is important that there is a heading on each of the charts to clearly identify 

the information that is being reviewed.

Question 2 

What are the organisational and task requirements for producing the charts?
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To create charts in your spreadsheet, you need to know the purpose of the chart 

and the data you plan to present. 

1is helps you choose the most appropriate type of chart to use. 1e data to be presented in 
the chart is known as the data range. 1is information may include text and numeric data. 
1e numeric data is what is represented in the chart and the text relates to the series (or 
group) of data.

1e following information explains the meanings of common terms.

The data 

range is 

the selection 

of values you 

choose from a 

worksheet to place in 

a chart; for example, all 

the numbers in one row or one 

column of data.

The legend is 

the key used 

to identify 

the various 

data series. If 

you include the 

series labels from your 

worksheet, Excel will add these 

to the legend. Otherwise the legend 

will simply say series 1, series 2, 

etc.

Categories are the names that are 

placed along the X-axis of a chart 

and are determined by the labels in 

your spreadsheet.

An axis is a line that labels the 

information in a chart according to 

the labels in the columns and rows 

of your spreadsheet. Axes provide 

a reference for measurement or 

comparison of the data in the 

chart. Most charts have 

a vertical axis (known 

as the Y-axis) and 

a horizontal axis 

(known as the 

X-axis). A
xi
s

D
at

a ra
nge

Category

Legend

3B Creating and modifying charts
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Producing a chart

To produce a chart, you must 5rst enter data into a worksheet. 

Select the data either by clicking and dragging over it with the mouse, or by selecting one of 
the cells, then holding down the Shi9 key and pressing the arrows on the keyboard. 

Use the Insert tab and select the appropriate chart under the Charts section. 1e type of 
chart you choose will depend on your organisational requirements. 

A chart is linked to the worksheet it is created from, so if you alter the data in the worksheet, 
the chart will be automatically updated.  

Practice task 13

Create a spreadsheet, with the data below for Hemline Miller, showing sales, customer 
numbers and quantities sold. 

1. Create a column chart that compares the sales data. Include the chart heading ‘Hemline 
Miller – January sales’.  

2. Create a scatter chart that compares customer numbers with quantity sold. Include the 
chart heading ‘January – customer numbers vs quantity sold’.

3. Create pie charts for the following, with relevant headings and data labels showing 
percentages of total sales:

a. Sales

b. Customer numbers 

c. Quantity sold

4. Save your 9le as ‘Hemline Miller January Report’.
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Practice task 14

Take the following steps to produce a column chart.

1. Open Excel and enter the data below into a worksheet. Save the worksheet as ‘Company 
cars’.

2. Select cells A4 to E9. 1is selection should cover all the labels and values. 1is selection 
has now become your data range. Do not include any blank rows or columns in your 
selected cell range.

3. Go to the Insert tab and select Insert column chart. 1e chart will now display as an 
object in your spreadsheet.
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4. To move the chart to a separate sheet in the workbook, go to the Design tab and select 
Move Chart.

  
A dialog box will appear. Select the option to place the chart in a new sheet. Give it an 
appropriate name, e.g. ‘Cars by state’. Click OK.

5. 1e chart will now have a separate sheet in the workbook. If you look at the worksheet 
names, you will notice that the chart now appears there.

6. If the data you want to include in a chart is not in adjacent rows and columns, use the 
Ctrl key to make multiple selections in diBerent locations on your worksheet.

Formatting charts

Once you have created a chart, you need to format it to suit your organisational 

requirements and make it easier to understand. 

You can improve the appearance and ease of understanding by using titles, axis labels, 
legends, colour and changes to layout. You can format the data range, text and legend or add 
a pattern to the chart area. Look at the following example of a chart and notice the diBerent 
components that can be formatted.
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Each component of the chart can be formatted by selecting the item, right-clicking on it to 
display the shortcut menu and then making formatting choices as appropriate. You can also 
use the Chart Tool buttons.

Purpose of formatting charts

You will need to format your chart to adhere to organisational and/or task 

requirements.

Formatting the chart can also enhance presentation and overall readability.

Balance the time taken in preparing the chart with the required output medium. For 
example, if you do not have a colour printer and are not presenting the charts electronically, 
it will not be necessary to spend a lot of time selecting colours. You will only need to ensure 
the font type and size is appropriate and that the chart is well presented.

All parts of the chart are separate components and can be formatted and adjusted as 
appropriate. To select a part of the chart, point and click to select it, then use the tool bar or 
right-click mouse shortcut menus to make appropriate changes. 

Titles in a chart are separate objects and can be moved around and resized by clicking and 
dragging with your mouse.



82
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU314
Design and produce spreadsheets

Practice task 15

Take the following steps to format a chart.

1. Open the spreadsheet with your Company Cars chart. Click inside any of the data series 
columns. Right-click your mouse and select Format Data Series. You will see the 
following dialogue box.

2. Click Fill and select Gradient 9ll, then choose a preset colour and click Close. You will 
notice that the data now has a shade eBect in the chart. If you want to change the look to 
something diBerent, instead of selecting Gradient 9ll, select Picture or Texture 9ll, and 
select an appropriate texture. 

3. Repeat this process to choose gradient 9lls for the other columns. 

4. 1e Plot Area is the space behind the columns. 1e Chart Area is the space behind the 
legend and the chart labels. Right-click in the Plot Area and select Format Plot Area. In 
the dialogue box, select Solid Fill and choose an appropriate colour. Click Close.

5. Right-click in the Chart Area and select Format Chart Area. In the dialogue box, select 
solid 9ll and choose an appropriate colour. Click Close. 

6. To add a border to the Chart Area, right-click and select Format Chart Area. From the 
dialogue box, select Border colour, choose Solid Line and make the colour black. Click 
Close.

7. To add a Chart title, select Chart Title and then Above Chart from the Layout tab.
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8. To add axis titles to the chart, from the Layout tab select Axis Titles, and add a 
horizontal title and vertical title.

9. To format the text in the Chart title, select the Chart Title, and use the formatting tools 
on the Home tab. 

10. To add data labels to the chart, select Data Labels from the Layout tab, and then select 
an appropriate position in the chart (such as centre). 

11. Format gridlines in the chart by right-clicking and selecting Format Major Gridlines. 
Select Line Style and choose a dashed line style. Click Close.

12. 1e chart should appear similar to the following example.

Modifying charts

A chart may need to be modi5ed. This could mean changing the chart type or 

data range, or reformatting the chart.

Formatting changes are done with the chart tools or by right-clicking in the chart area or 
plot area. Once you insert a chart into your worksheet, you will notice that two new tabs 
appear – Design and Format.

1e following provides a list of tools you can use to format and modify charts.
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Design tools

 • Design tools allow you to change the type of chart selected, adjust the style and layout, 

alternate the view of data between row or column, and check or adjust the data selected.

 • The Chart Layouts section can be used to change the way the chart is set out. Layout tools 

allow you to adjust the appearance of the chart by adding titles, labels, gridlines, etc.

 • Chart Styles can be used 

to change the colours and 

presentation of the chart. 

 • The Data section can be used to 

change the data range or adjust 

the way data is presented in the 

chart.

 • You can select Change Chart 

Type to change the chart type (for 

example, from a column chart to a 

line graph).

Format tools

 • Format tools enable you to alter the general appearance of the chart, such as colours, font 

type and font size.

 • You can use the Current Selection group to adjust the appearance of various components of 

the chart (such as chart title and plot area).

 • The Insert Shapes section can be used to add shapes and text. You can also use the Insert 

tab to add pictures from external sources.

 • The Shape Styles and WordArt Styles sections can be used to add effects to shapes and 

labels used in the chart.

 • The Arrange section can be used to display the selection pane, which enables you to hide or 

display charts in the spreadsheet.

 • You can also change the height and width of the chart, adjusting the overall layout. 
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In addition, you can format the chart by clicking on it and selecting options from the drop-
down list. 1e 9rst option allows you to add elements such as a trendline and data table, 
whereas the second option allows you to change the style and colour scheme.

A window will also appear on the right allowing you to format the plot area.

Summary

• A chart is a graphical representation of selected worksheet data.

• Charts are visually appealing and make it easy to display comparisons, patterns and 
trends in data.

• 1e type of chart you choose to display data depends on organisational and task 
requirements.

• Each component of a chart can be formatted and adjusted as needed.
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Learning checkpoint 3 
Produce simple charts

Part A
1. Write a short paragraph for each of these chart types explaining the type of data most 

suited to each type:

a. Pie

b. Column

c. Scatter

d. Line
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2. Use the data below to create the following charts. Save the spreadsheet to an appropriate 
location and name it ‘Jim’s Booksellers – January sales comparison’.

a. A pie chart to show percentage achieved for individual sales consultants.

b. A column chart to show target and actual sales 9gures for individual sales 
consultants.

c. A scatter chart to show clusters of actual sales with percentage achieved.

To calculate the percentage in the last column you need a formula that divides the actual 
sales by the target sales.

Jim’s Booksellers 

January comparison – target sales �gures to actual sales �gures

Sales consultant Target Actual Percentage of 

target achieved

Amanda $80000 $71891

Geraldine $75000 $72910

Harry $68000 $62820

Jim-Bob $87000 $92192

Maureen $85000 $78282

Part B
Open the spreadsheet ‘Jim’s Booksellers – January sales comparison’, which you made in 
Part A. Format the pie chart as follows:

1. Use the Design tab tools to make adjustments to layout and style. Make choices 
according to your preference.

2. Add data labels to the charts.

3. Add gridlines, as appropriate, to the charts.

4. Format the plot area using a gradient.

5. Add a shape to the chart to identify the highest-achieving sales consultant.

6. Use WordArt styles to format the chart title.

7. Use Shape styles to apply dark borders around the chart.

8. Preview your charts before printing on an individual page.
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You must be able to produce quality spreadsheets and charts that adhere to 

organisational and task requirements.

When preparing spreadsheets and charts, you must comply with the required time lines 
and task instructions. If you believe that either the time line or task instructions need to be 
altered, you should discuss this with your supervisor or the person who has requested the 
work. Many businesses have strict deadlines for completing tasks. Failing to meet deadlines 
can have an impact on other tasks and teams in the organisation. 

1e 9nal spreadsheet and chart must be thoroughly checked and proofed before completion 
to ensure the correct message and company image are delivered to the audience. Previewing 
your spreadsheet and chart before printing can save time and help you work out where 
adjustments need to be made.

It is easier to access spreadsheets that have already been created and stored using appropriate 
9le referencing and saving options. Saving 9les in the correct location is important as it 
improves business e
ciency and ensures all relevant personnel can access the spreadsheets 
quickly and easily. 

In this topic you will learn about:

4A Finalising and reviewing spreadsheets

4B Printing spreadsheets 

4C  Naming and storing spreadsheets appropriately
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There are some standard ways to help meet time lines for data entry and to 

meet the accuracy requirements for the task.

Whenever you are given a work task, you need to 
plan a time line. A time line breaks the task into steps 
and details when each step must be completed by.

Find out when the spreadsheet is required and enter 
the date in your diary. Identify and plan the task 
requirements to work out how long it is likely to 
take. Careful planning is necessary to avoid a last-
minute panic. If you are developing a spreadsheet for 
someone else, always clarify exactly what is required; 
for example, are formulas needed and do you have to 
create a new column? If you have to write formulas, 
make sure you allow enough time to have them 
checked by your manager.

If you are relying on others to provide you with data, you need to allow for this. You should 
give reminders and follow up so others do not delay the project.

Organisational time lines

Always ensure that the time line set is realistic and achievable.

You may be instructed by your supervisor on the deadline for completing set tasks; for 
example, preparing a draJ summary report by 2pm. You may also have regular deadlines 
for common tasks such as creating a monthly report of customers who are overdue in 
paying their invoices.

Using a diary system and a to-do list can help you prioritise tasks and stay aware of the time 
lines required for tasks.

You may 9nd you have conIicting work priorities and time lines. In these situations, your 
supervisor may be able to help you by suggesting ways to meet the deadline or they may be 
willing to adjust the deadline or task requirements.

4A Finalising and reviewing spreadsheets
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Preparing a checklist

Creating spreadsheets will become easier once you are familiar with your 

organisation’s requirements. 

In the meantime you can prepare a checklist to help you plan your work tasks. 

Look at the following example of a checklist.

Task Deadline Requirements Completed

Create a 

spreadsheet 

for the 

manager

Tuesday 20 

March

 • Collect the product data

 • Check the data

 • Enter the data

 • Proofread the data

 • Format the spreadsheet using the 

organisation’s style guide

 • Create a new column named 

‘Interest’

 • Write a formula to calculate 10 

per cent of customers’ balances

 • Create a column named ‘Sale 

price’

 • Write a formula to calculate the 

new sale price



Accuracy of data

The accuracy of the outputs from your spreadsheets will depend on the 

accuracy of the data going into them.

You must ensure that the data being entered is good enough to achieve the task; for example, 
if the manager wants calculations to two decimal places and your data is very rough, then 
the answers you provide may be meaningless.

Try to stick to time lines and use the soJware appropriately and e
ciently to save time and 
ensure that data is accurate. It is better to complete the task carefully and methodically 
rather than producing work that needs to be repeated due to inaccuracies.  

When you are planning a spreadsheet task, you may think that designing and creating your 
spreadsheet is the biggest part of the job. Yet collecting, checking and entering the data 
can take a long time. 1is part of the process can cause delays, especially if you need other 
people to contribute data. 1e data that goes into your spreadsheet needs to be complete and 
accurate to give the correct results.

Use shortcut menus (by right-clicking the mouse button) to bring up quick commands for 
undertaking actions. Use shortcut keys to undertake actions quickly (e.g. use Ctrl+X to 
cut and Ctrl+V to paste). Familiarise yourself with the tools available in the ribbons and 
the groups of tools under each tab. If you think there should be an easier way of doing 
something, there probably is. Remember, you can always search the Excel help facility for 
assistance.

Use the numeric keypad on your keyboard to enter data, and try to improve your typing 
speed and accuracy for text-based entries.
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Checking and proofreading data 

When using formulas and functions, you need to make sure the result you get is 

correct. 

If you are working under tight deadlines, it is easy to make mistakes, such as subtracting 
one cell from another instead of adding them. 

Proofreading is the process of carefully reviewing a document for any mistakes. To 
proofread a spreadsheet, you need to check for correct layout, ensuring consistent styles 
have been used, that the information is clear and easy to read, and the data is accurate.

To check values, compare the values you have entered with the values you were given. Make 
sure that you have not made any errors when copying values and that you have entered all 
the data in the correct places.

To check errors in labels, you can use the Spelling function under the Review tab. 

1is will pick up words you have misspelt, but will not help you with product names or 
customer names and addresses, so you will need to check these carefully. 

Practice task 16

Read the case study, then answer the questions that follow.

Case study
Crystal works as an administrative of�cer for a local government agency’s conference and meeting 

centre. Her role involves coordinating the bookings for the centre, as well as maintaining an 

adequate supply of stock and resources for the centre’s clients. Crystal’s supervisor has asked her 

to produce a report by the end of the day summarising all the clients that have used the centre in 

the past 12 months, along with a chart that shows the percentage of their usage. Crystal went about 

her daily tasks as usual. She allowed herself the last hour of the day to prepare the report and chart. 

When Crystal began preparing the report and chart, she realised that it was a much bigger job than 

she had anticipated. Crystal realised she needed a lot more time to compile the information for her 

supervisor.

Question 1 

What should Crystal do?
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Question 2 

What could Crystal have done differently when agreeing to the deadline for the task?

Question 3 

How important is the data-gathering component of this task?

Question 4 

What does the task actually require Crystal to do?
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A workplace normally has standards for sta  to adhere to when printing. 

For example, you may be expected to use recycled paper when printing draJs. Using print 
preview to proof spreadsheets before printing can help to save paper.

Organisational and task requirements may specify things like the number of copies you 
should print, and whether colour printing is permitted. 

When preparing to print spreadsheets, ask yourself the following questions:

 • What do I need to print – workbook, active spreadsheet, selected data or chart?

 • Did I preview before printing?

 • If it is a draft spreadsheet, should I print on recycled paper?

 • How many copies of the spreadsheet do I need?

Print preview 

Print previewing lets you check spreadsheet accuracy, layout, presentation, 

consistency and readability. 

Part of the proo9ng process for 9nalising spreadsheets and charts is to preview them before 
printing. Print preview lets you check that the requirements originally speci9ed have been 
met and allows you to check layout and overall appearance.

To preview your spreadsheet or chart, go to the File tab and select Print. 1e preview will be 
visible in the right-hand side.

4B Printing spreadsheets 
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If you have selected the chart object, the data will not be displayed in print preview, only 
the chart. Excel assumes that if you have selected the chart, that is all you want to print. If 
you want to preview both the data and the chart, ensure the worksheet is active and not just 
the chart.

If the chart is a separate sheet in the workbook and not an object with data, to preview the 
chart you will need to select the worksheet that it is contained in.

1e default option for print preview is to preview only the current worksheet in view. If you 
want to view the entire workbook, you need to select all worksheets. To do this, hold down 
the Ctrl key and click on each worksheet before viewing print preview.

Be careful if you are selecting multiple worksheets. If you have a number of worksheets 
active at one time, any data that you alter and input will be repeated on all of the selected 
worksheets. To deactivate multiple selected worksheets, simply click on one worksheet, 
which will become the active worksheet.

Print tools

There are a number of tools you can access and apply before printing your 

spreadsheet.

To access these options, select File, then the Print tab. Here you can do the following:

• print the workbook, spreadsheet or selected object

• enter the number of copies you want to print 

• select double-sided printing

• alter the orientation from portrait to landscape

• choose the paper size

• adjust margins and scaling.

Further page setup options are available by clicking on the link below the Scaling drop-
down menu.

Below print preview there are buttons that allow you to:

• view next and previous pages

• zoom in or out on the spreadsheet

• show margins of the document and, if needed, make manual adjustments using 
your mouse.

1e 9rst drop-down menu under Settings identi9es what is to be printed and will show 
active sheets. From the drop-down menu you can choose to print the entire workbook or a 
selection of cells. 

From Page Setup you can adjust the scaling. Scaling allows you to adjust the size of the 
printout, making it larger or smaller on the printed page.

Alter the printer that you are printing to if needed, and select how many copies you want to 
print. It is also possible to alter how the multiple printed copies are collated. 

You can adjust the size of the printout by altering Adjust to more than 100 per cent of 
normal size in the Page Setup dialog box. 
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Printing a selection from a workbook

You may be dealing with a very large worksheet or your manager may have 

requested only some information from a worksheet. 

If this occurs, you may need to print only part of a worksheet. To do this, select the cells you 
wish to print. From the File tab select the Print tab. From the 9rst drop-down menu under 
settings choose Print Selection. Click the Print button.

If you want to print formulas entered in a worksheet, go to the Formulas tab and select 
Show Formulas from the Formula Auditing section.

When in print preview, go to Page Setup and select Fit to to 9t your worksheets on one page 
or on a number of pages.

To print an entire workbook comprising multiple worksheets, follow the instructions for 
printing a selection, but from the drop-down menu, select Print Entire Workbook.
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Practice task 17

Open the 9le Hemline Miller January report.

1. Preview the spreadsheet. Check the appearance of the data and charts, and make any 
necessary adjustments before printing. Print one copy of the spreadsheet.

2. Select cells A4 to B9 – this will select only the store and sales data. Print only the 
selected data.

3. Select the column chart and select File, then Print. Notice that Print Selected Chart is 
automatically selected. Alter the printer that you are printing to if needed, and select 
how many copies of the chart you want to print. Click the Print button. 

4. Print out the Store and Sales columns. Adjust the size of your selection until it is 150 per 
cent of normal size.
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You need to follow any requirements of your organisation for naming and 

storing spreadsheet 5les. 

1is will make it easier for you and your colleagues 
to retrieve spreadsheets when needed. Some 
organisations have strict naming standards that must 
be adhered to, such as all project 9les having to start 
with ‘PRO’. Another example is using product codes 
rather than descriptions. It is better to use a product 
code as this is individual, whereas there may be many 
products with similar descriptions, so it can become 
confusing. Find out the naming standards for folders 
and 9les in your workplace.

When you have a spreadsheet stored in a folder, it must have a unique name. No two 
spreadsheets stored in the same location can have the same name. Excel will let you know 
if a 9le with the same name already exists, and you will have to save the 9le using an 
alternative name. If you are not sure of the procedures for saving and storing spreadsheets, 
ask your supervisor.

When closing Excel, always follow procedures and exit the program correctly. 1is ensures 
the data you have entered into the spreadsheet doesn’t become corrupted the next time the 
spreadsheet is used.

Naming spreadsheets

As well as placing folders and 5les in the appropriate locations, you also need 

to give them appropriate names. 

Naming conventions need to be kept consistent, simple and meaningful. 1e 9le name you 
choose may include any combination of numbers or letters. Some characters cannot be used 
in 9lenames, including: . , / \ * ? <. Appropriate naming conventions help people identify 
and retrieve 9les.

When saving, Excel automatically adds a 9le extension to your spreadsheet. 1e 9le 
extension identi9es the type of program that the spreadsheet has been created in, and tells 
your computer system what program to use when opening the 9le again. In Excel 2016, all 
spreadsheets are saved with the extension .xlsx. For much earlier versions of Excel (1997 to 
2003), the extension is .xls.

Excel 2016 has some features that are not available in previous versions. If you are creating 
a spreadsheet that others need to access electronically with a version older than Excel 2007, 
you will need to work in compatibility mode. Compatibility mode turns oB some of the 
new features, which ensures that people working in older versions will have full editing 
capabilities.

To save a spreadsheet in compatibility mode, go to the File tab, select Save As, and select 
Excel 97–2003 Workbook in the Save As Type list. 

4C Naming and storing spreadsheets 
appropriately
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Storage security

Information is a valuable asset in any organisation. How information is stored 

and the security measures used to protect it are central to an organisation’s 

procedures.

1e spreadsheets you create will usually be stored on a server that allows access to multiple 
users. A server delivers information and soJware to other computers linked by a network.

To enable staB to log on to a server, the systems administrator will issue each person with a 
username. 1e user must then create a password. Usernames and passwords:

• give users access to the information they require to complete work tasks

• allow users to have diBerent levels of access to information.

You may 9nd that some of the spreadsheets you work with are con9dential. Ask your 
manager for your organisation’s policies regarding con9dential material.

Authorised access

Many organisations have protocols in place where you can only access those 

parts of the shared network that are relevant to your work or your department. 

Authority to access various parts of the shared network are provided by the organisation’s 
systems administrator. If you do not have access to a part of the shared network that you 
need to access, discuss this with your manager.

It is also possible to limit access to spreadsheets that you create by using passwords. 
Passwords are commonly used for spreadsheets that contain con9dential, private or sensitive 
information, such as pro9t analysis and staB details. Passwords can be used to limit access 
to opening spreadsheets or to limit the ability to modify information in the spreadsheet. 

To place a password on a spreadsheet, open a spreadsheet and select the File tab. Under 
Info, select Protect Workbook, then select Encrypt with Password under the drop-
down menu.

Type in a password (write down the password or ensure it is one you will easily remember) 
and click OK. Save your document. If an error message appears stating, ‘1ere is already 
a 9le with that name existing, do you want to replace existing 9le?’, select Yes. 1is will 
override the current 9le and replace it with one with a password.

Close the spreadsheet and open it again to test that the password is working. 

Backing up and safeguarding data

Many organisations have set procedures for  

backing up 5les. 

Backing up 9les is an important practice as it helps to 
prevent the loss of documents and information, and is 
extremely useful if something happens to the network or 
computer system as you will be able to retrieve previous 
documents.

In many large organisations this is administered 
through the IT department and is an automatic process. 
In this case, the only thing you need to do is save your 
9les to the appropriate network drive and folders.
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In smaller organisations, it may be necessary for you to back up 9les to an external network 
or drive. 1is may be done on a daily or weekly basis. Check with your supervisor for the 
relevant backup procedures.

USB sticks are useful for storing and backing up information, especially when you require a 
portable copy of the information.

Data also needs to be safeguarded against accidental or deliberate damage. 

Data loss is usually caused by human error or system failure. Many organisations use a data 
cartridge or cloud-based storage to back up information on a database. 

A server is made up of many 9les and folders. Organising this information helps users 
9nd what they want. If you are saving information onto a server, make sure you know 
where to put it. Save your work frequently at various stages throughout the production 
process. Always follow your organisation’s policies regarding the storage and security of 
spreadsheet 9les. 

Policies for 1ling hard copies of spreadsheets

It’s common for spreadsheets stored digitally to also be stored in hard copy. 

1is guards against a computer system failure. Hard-copy storage requires space and the 
establishment of a 9ling system that uses consistent, simple and meaningful names, similar 
to digital storage.

Hard-copy spreadsheets must be kept up to date. Physical storage needs to be managed well 
since storage space is oJen scarce and valuable. Old or superseded spreadsheets should be 
destroyed on a regular basis. Retention schedules list the time frames that spreadsheets need 
to be kept for before they can be destroyed. Spreadsheets without permanent value may be 
scheduled for eventual destruction. Find out what kind of hard-copy 9ling system is used at 
your workplace; ask your supervisor if you are unsure.

Exiting the application safely

After creating or modifying a spreadsheet, you need to exit the software 

application without causing damage or data loss. 

Data loss occurs when a computer program stops performing its expected function. OJen 
the program or even the whole computer may appear to freeze. All computer users will 
experience data loss at some time. Data may have been accidentally erased or corrupted and 
made inaccessible.

To exit the spreadsheet program, click the Exit button, which is located in the top right 
corner of the window. If you have recently made changes to your spreadsheet, you will be 
prompted to save your document.
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Precautions to prevent data loss

 • Try to work on only one spreadsheet at a time.

 • Data loss can occur if someone else tampers with your work. If you are working 

on a spreadsheet at your workstation, lock your computer or exit the application 

before leaving your workstation unattended.

 • If you need to work with multiple applications open, make sure you close 

applications that are no longer needed. This will help your computer work more 

quickly and will prevent data loss in the event of computer failure.

 • If your computer starts to behave in an unusual way, save your work and shut it 

down immediately, and do not turn it back on until you get assistance.

 • Make sure your computer has up-to-date antivirus, antispyware and �rewall 

programs to protect it against malware from the internet. Also check that it has the 

latest security updates.

Practice task 18

Read the 9rst case study, then answer the questions that follow.

Case study 1
Matthew works as an of�ce administrator in a large organisation. His duties include formatting 

reports and saving them on the server. He is also responsible for backing up the server at the end of 

each day. 

At the end of a busy day, Matthew has completed several reports for different departments in the 

organisation. He saved each of them in a different location, and it took him a while to work out 

where they all belonged. He wasn’t sure if he saved them all in the correct place. After this, he was 

running late and decided not to back up the server. 

The next morning, the reports that Matthew had saved were needed for an important board meeting. 

However, during the night a virus had infected the server, destroying all the information from the 

previous day.

Question 1 

What would be the consequences if Matthew did not save some of the reports in the correct 

place?

Question 2 

Can you think of any consequences of not backing up data on the server?
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Read the second case study, then answer the questions that follow.

Case study 2
Fred has retired from an organisation after working as an administrative assistant for 10 years. 

The areas Fred was responsible for were accounts and projects. The day after he retired, someone 

needed a �le that Fred had created and stored. The �le contained vital accounting information. It 

was discovered that Fred had saved more than 500 �les in a variety of folders and the �le could 

not be located. The folders had ambiguous names such as ‘Folder1’ and ‘Folder2’ and the �les had 

names such as ‘august1’ and ‘march2’.

Question 1 

Describe why Fred’s folder and �le naming system failed.

Question 2 

Fred was responsible for two areas. What could he have done to make sure �les could be easily 

located?

Question 3 

Explain why folder and �le names should be consistent, simple and meaningful.
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Summary

• Make sure you have formatted, checked all formulas and functions and proofread your 
spreadsheet before printing.

• Working within a designated time line means you must plan your work accordingly.

• Collecting, checking and entering data can be a big part of the task.

• You should always preview your work before printing.

• It is possible to print a whole spreadsheet or parts of a spreadsheet. 

• A chart can be printed on its own or as part of a worksheet.

• You need to understand your organisation’s policies and procedures for saving and 
storing spreadsheets.

• You may need to restrict access to sensitive information by setting a password.

• It is important to safeguard and back up 9les.
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Learning checkpoint 4 
Finalise spreadsheets

Part A
1. Using the data below, create a professionally presented spreadsheet and appropriate 

chart to compare daily rainfall each year.

Rainfall in millimetres

2017 2018

1 January 23 34

2 January 25 41

3 January 34 42

4 January 37 20

5 January 42 23

6 January 19 24

7 January 20 33

2. Print your spreadsheet on one page – landscape page orientation, incorporating the 
chart as an object of the spreadsheet.

3. Save the spreadsheet to an appropriate location and name it ‘Daily-rainfall’.

4. Use the checklist below to ensure that you adhered to requirements for 9nalising your 
spreadsheet.

Task What to check for 

Data entry  • Accuracy of data input

Data 

formatting

 • Formatted professionally – appropriate use of styles, 

colour, font type, font size, bold, italics, underline, borders, 

shading, alignment, etc.
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Task What to check for 

Create chart  • Chart inserted as an object

 • Selected chart meets analysis requirements

 • Formatted professionally – appropriate use of layout and 

styles, colour, labels, titles and borders

Save �le  • Saved as ‘Daily-rainfall’

 • Saved to appropriate �le location – drive and folder

Print preview  • Print preview used to check data, layout and overall 

presentation

 • Any required adjustments to content, layout and 

appearance made

Print  • Printed single page to selected printer

 • Printed in landscape orientation

 • Spreadsheet data and chart on same page

Exit Excel  • Exit Excel ensuring all work is saved appropriately

Adhere to task 

requirements

 • Followed instructions 

 • End result: One-page printout – spreadsheet data and 

chart, professionally presented

Meet 

designated 

time lines

 • Able to meet designated time line 

 • Negotiated extension to time line if needed

Part B
1. What can you do to improve your speed and accuracy when working with spreadsheets?
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2. Why is it good practice to preview before you print the 9nal spreadsheet?

3. What tools and systems should you use to ensure that you meet time lines?

4. How can you name and store your spreadsheets to ensure ease of access in the future?
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5. What can you do to prevent loss or damage to your spreadsheets?

Part C
Use the following data to create a professionally presented spreadsheet and chart that 
compares target stock supply with actual stock supply.

Save the spreadsheet to an appropriate location and name it ‘January stock supply’.

Our Of�ce 2 U – January stock supply

Target vs actual

Product code Target Actual Percentage of target that was 

achieved

PC239 4000 4309

PC340 3000 2987

PC401 2500 1076

PC509 4300 4109

PC617 3800 4026

Include the following components in your spreadsheet:

• Footer stating the 9le reference details

• Chart legend, chart title and axis titles

• Blue, Arial, 10pt font

Make other appropriate formatting choices to ensure the spreadsheet and chart are 
professionally presented, such as a landscape orientation and centring the spreadsheet on 
the page – horizontally and vertically.

Make sure you:

• preview before printing – print the spreadsheet and chart on separate pages

• save to an appropriate location and name the spreadsheet ‘January-stock-supply’

• exit the program ensuring that all 9les have been saved as appropriate.
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